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Warning and Disclaimer 

 

This study material is designed to provide information about 'Certificate in Digital Techniques Application'. While every effort has been made 
to make this study material as complete, comprehensive and as accurate as possible, no warranty or fitness is to be implied. The information 
is provided on an “as is” basis. Hewlett Packard Enterprise shall not have any liability or responsibility to any person or entity with respect to 
any loss or damages arising from the information contained in this study material. Internet websites offered as citations and/ or sources for 
further information may have changed or disappeared between the time this study material is written and the time when it may be read by the 
reader.  
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Chapter 1:   Computer Fundamental 
Introduction 

Computer Fundamentals are designed to equip learners with the foundational knowledge and skills required to 

understand, utilize, and navigate the world of computers effectively. Computer Fundamentals provide learners 

with a broad understanding of computers, their components, functions, and applications, ensuring they are 

prepared to use computers effectively for personal, academic, or professional purposes. 

 

 

Understanding Basic Concepts 

Grasp the definition and importance of computers in daily life and various industries. Learn about the history and 

evolution of computers. Differentiate among various types of computers (e.g., Desktops, Laptops, Servers, 

Supercomputers). 

a. Hardware Components 

Identify the primary components of a computer system, including input, output, processing, and storage devices. 

Understand the role of Central Processing Unit (CPU), memory (RAM/ROM), and peripheral devices. Learn the 

significance of hardware specifications for performance. 

b. Software Components 

Understand the types of software: system software (e.g., operating systems), application software, and utility 

software. Learn about operating system functions and their importance in managing hardware resources. Explore 

common software applications and their use in productivity, communication, and entertainment. 

c. Data Representation and Handling 

Learn how computers represent data using binary and other numeral systems. Understand basic data units (bit, 

byte) and storage measurement (KB, MB, GB, etc.). Explore data processing techniques and file management. 
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d. Applications of Computers 

Familiarize with real-world applications of computers in fields like education, healthcare, business, and 

entertainment. Gain insight into the role of computers in communication (e.g., email, video conferencing) and 

digital collaboration. Understand the impact of emerging technologies like artificial intelligence, cloud computing, 

and IoT. 

e. Introduction to Networking 

Learn basic networking concepts, including the Internet, intranet, and different types of networks (LAN, WAN, 

MAN). Understand the importance of IP addresses, DNS, and protocols in enabling communication. 

f. Computer Security and Ethics 

Identify common threats like viruses, phishing, and hacking. 

Learn basic measures for securing data and systems, such as using strong passwords and antivirus software. 

Understand the importance of ethical practices in computing and respecting privacy. 

g. Skill Development 

Develop the ability to operate a computer, manage files, and navigate operating systems. 

Gain basic proficiency in common software applications (e.g., word processors, spreadsheets, and browsers). 

Cultivate troubleshooting skills for common hardware and software issues. 
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Today’s world is an information-rich and it has become a necessity for everyone to know about computers. A 

computer is an electronic data processing device, which accepts and stores data input, processes the data input, 

and generates the output in a required format. The purpose of this tutorial is to introduce you to Computers and 

its fundamentals. 

Functionalities of a Computer 

If we look at it in a very broad sense, any digital computer carries out the following five functions: 

Step 1 - Takes data as input. 

Step 2 - Stores the data/instructions in its memory and uses them as required. 

Step 3 - Processes the data and converts it into useful information. 

Step 4 - Generates the output. 

Step 5 - Controls all the above four steps. 

Advantages of Computers: - 

High Speed, Accuracy, Storage Capability, Diligence, Versatility, Reliability, Automation, Reduction in Paperwork 

and Cost 

Disadvantages of Computers: -  

Dependency, No Feeling, No I.Q.,  

Applications of Computer:  

Business Payroll calculations, Budgeting, Sales analysis, Financial forecasting, Managing employee database, 

Maintenance of stocks, etc. 

Banking Online accounting facility, ATM machines etc. 

Insurance Procedure to continue with policies, starting date of the policies, next due instalment of policy, maturity 

date, interests due, survival benefits Bonus etc. 

Education The computer provides a tool in the education system known as CBE (Computer Based Education). 

Marketing Advertising, Online Shopping etc. 

Healthcare Computers have become an important part in hospitals, labs, and dispensaries. They are being used 

in hospitals to keep the record of patients and medicines. It is also used in scanning and diagnosing different 

diseases. ECG, EEG, ultrasounds and CT scans, etc. are also done by computerized machines. 

Engineering Design One of the major areas is CAD (Computer Aided Design) that provides creation and 

modification of images. Structural Engineering, Industrial Engineering, Architectural Engineering., Computers help 

to designing both 2D and 3D drawings. 

Military Computers are largely used in defence. Modern tanks, missiles, weapons, etc. Military also employs 

computerized control systems. 
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Communication: Communication is a way to convey a message, an idea, a picture, or speech that is received and 

understood clearly and correctly by the person for whom it is meant. Some main areas in this category are: E-

mail, Chatting, Usenet, and Video-conferencing. Government Computers play an important role in government 

services. Some major fields in this category are Budgets, Sales tax department, Income tax department, 

Computerization of Voter ID card and PAN card, Weather forecasting etc. 

Generations of Computer 

S. No. Generation & Description 

1 First Generation 
The period of first generation: 1946-1959. Vacuum tube based. 

2 Second Generation 
The period of second generation: 1959-1965. Transistor based. 

3 Third Generation 
The period of third generation: 1965-1971. Integrated Circuit based. 

4 Fourth Generation 
The period of fourth generation: 1971-1980. VLSI microprocessor based. 

5 Fifth Generation 
The period of fifth generation: 1980-onwards. ULSI microprocessor     based. 
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Types of Computers 

Sl. No. Type Specifications 

1 PC (Personal Computer) It is a single user computer system having moderately powerful 
microprocessor 

2 Workstation It is also a single user computer system, similar to personal 
computer however has a more powerful microprocessor 

3 Mini Computer It is a multi-user computer system, capable of supporting 
hundreds of users simultaneously. 

4 Main Frame 
It is a multi-user computer system, capable of supporting 
hundreds of users simultaneously. Software technology is 
different from minicomputer. 

5 Supercomputer It is an extremely fast computer, which can execute hundreds 
of millions of instructions per second. 

 

 

CPU (Central Processing Unit) 

CPU is considered the brain of the computer. CPU performs all types of data processing operations. It stores data, 

intermediate results, and instructions (program). It controls the operation of all parts of the computer. CPU itself 

has the following three components:  

• ALU (Arithmetic Logic Unit)  

• Control Unit (CU) 

• Memory Unit 
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ALU (Arithmetic Logic Unit)  

This is a key component of the CPU that performs arithmetic operations (e.g., addition, subtraction) and logical 

operations (e.g., AND, OR). 

 

Control Unit (CU) 

The Control Unit (CU) is a crucial component of a computer's Central Processing Unit (CPU). Its primary role is 

to manage and coordinate the operations of the computer by directing the flow of data between the CPU and 

other components. 

Memory 

A memory is just like a human brain. It is used to store data and instructions. Computer memory is the storage 

space in the computer, where data is to be processed and instructions required for processing are stored. The 

memory is divided into large number of small parts called cells. Each location or cell has a unique address, which 

varies from zero to memory size minus one. For example, if the computer has 64k words, then this memory unit 

has 64 * 1024=65536 memory locations.  

The address of these locations varies from 0 to 65535. Memory is 

Primarily of two types - Primary Memory/Main Memory, and Secondary Memory 

Primary Memory 

Definition: Primary memory (or main memory) is directly accessible by the CPU and is used to store data and 

instructions temporarily while the computer is running. 

Characteristics: 

Volatile: Most primary memory (like RAM) loses its data when the power is turned off. 

High Speed: Faster than secondary memory for read/write operations. 

Limited Capacity: Usually smaller in size compared to secondary memory. 

Directly Accessed: Communicates directly with the CPU. 
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RAM (Random Access Memory): 

Temporary storage for data and programs being used. 

Types: DRAM (Dynamic RAM), SRAM (Static RAM). 

 

ROM (Read-Only Memory): 

Contains data permanently written during manufacturing (e.g., BIOS). 

Types: PROM, EPROM, EEPROM. 

Secondary Memory 

Definition: Secondary memory (or storage) is used to store data and programs permanently or semi-permanently 

for long-term use. 

Characteristics: 

Non-Volatile: Retains data even when the power is off. 

Slower Speed: Compared to primary memory. 

Large Capacity: Significantly larger than primary memory. 

Indirect Access: Data must be loaded into primary memory for processing. 

Types of Secondary Memory: 

Magnetic Storage: Hard Disk Drives (HDDs), floppy disks. 

Optical Storage: CDs, DVDs, Blu-ray discs. 

Solid-State Storage: SSDs, USB flash drives. 

Cloud Storage: Online storage services like Google Drive or Dropbox. 
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Examples: 

Hard drives for saving documents, software, and media. 

External USB drives for backups. 

 

 

 

Memory Units 

Memory unit is the amount of data that can be stored in the storage unit. This storage capacity is expressed in 

terms of Bytes. 

BIT 

Definition: 

A bit (short for "binary digit") is the smallest unit of data in a computer and can hold only one of two values: 

0 (off/false) 

1 (on/true). 

Key Characteristics: 

Represents the smallest piece of information. 

Used in binary systems to encode data, such as text, numbers, or instructions. 

Examples of Usage: 

A single light switch being "on" or "off" is analogous to a bit. 

In data transfer rates, speeds are often measured in bits per second (e.g., Mbps = megabits per second). 
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BYTE 

Definition: 

A byte is a collection of 8 bits. It is the standard unit of data used to represent a character (like a letter, number, 

or symbol) in many encoding systems, such as ASCII. 

Key Characteristics: 

1 Byte = 8 Bits. 

Sufficient to represent 256 different values (2⁸ = 256), ranging from 00000000 (0 in decimal) to 11111111 (255 in 

decimal). 

Used to measure the size of files or storage (e.g., kilobytes, megabytes). 

Examples of Usage: 

The letter "A" is represented in ASCII as 01000001, which takes 1 byte. 

File sizes (e.g., an image might be 1 MB, which is roughly 1 million bytes). 

Memory storage Unit 

The following table explains the main memory storage units 

Sl. No. Unit Description 

1 Bit (Binary Digit) A binary digit is logical 0 and 1 representing a passive or an 
active state of a component in an electric circuit. 

2 Nibble A group of 4 bits is called nibble. 

3 Byte A group of 8 bits is called byte. A byte is the smallest unit, 
which can represent a data item or a character. 

4 Kilobyte (KB) 1 KB = 1024 Bytes 
5 Megabyte (MB) 1 MB = 1024 KB 
6 Gigabyte (GB) 1 GB = 1024 MB 
7 Terabyte (TB) 1 TB = 1024 GB 
8 Petabyte (PB) 1 PB = 1024 TB 

About Microprocessor 

A microprocessor PC is essentially a computer system where the central processing unit (CPU) is based on a 

microprocessor chip. The microprocessor interacts with various components such as memory, storage, and I/O 
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devices to perform a wide range of tasks and operations. Microprocessors continue to evolve, offering greater 

performance and efficiency for both general and specialized computing applications. 

 

Inside Motherboard 

The motherboard is the main printed circuit board (PCB) that serves as the central hub for communication and 

connectivity between all of the components in a computer system. Inside a motherboard, you will typically find 

various components and slots that allow different hardware parts to connect and work together. Here's an overview 

of the main components found inside a motherboard: 

 

 

 

 

 

 

 

 

 

 

CPU Socket 

Description: This is where the Central Processing Unit (CPU) is installed. The CPU is the brain of the computer, 

performing the calculations and instructions needed for the system to function. Common Types: LGA (Land Grid 

Array) for Intel CPUs, PGA (Pin Grid Array) for AMD CPUs. 

RAM Slots (DIMM Slots) 

Description: These are slots for inserting memory modules (RAM). The number of RAM slots can vary depending 

on the motherboard model, but most motherboards support two or four. Common Types: DDR4, DDR5. 

Chipset 

Description: The chipset acts as a bridge between the CPU and other components of the motherboard, including 

RAM, storage devices, and peripherals. It manages data flow between the processor and other components.    

Northbridge (older systems): Handles communication between the CPU, RAM, and high-speed devices like 

GPUs.Southbridge (older systems): Controls I/O functions, such as USB ports, SATA connections, etc. 
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PCIe Slots (Expansion Slots) 

Description: These slots are used to add expansion cards, such as graphics cards (GPU), network cards, sound 

cards, storage controller cards, etc. Common Types: PCI Express x16 (for GPUs), PCI Express x1 (for other 

cards). 

Power Connectors 

Description: These connectors supply power to the motherboard and other components. Types: 24-pin ATX power 

connector (for power to the motherboard), 8-pin (or 4+4) connector for additional CPU power. 

Storage Connectors 

Description: These connectors allow you to attach storage devices like hard drives (HDDs), solid-state drives 

(SSDs), and optical drives. 

Types: 

• SATA ports (Serial ATA): For connecting traditional hard drives and SSDs. 

• M.2 Slots: For connecting M.2 NVMe or SATA SSDs. 

• U.2 Ports: For high-speed SSDs (less common). 

 

Integrated Graphics (iGPU) 

Description: Some motherboards come with an integrated GPU, especially in budget systems or CPUs with 

integrated graphics (e.g., Intel's i3/i5/i7 CPUs or AMD's APUs). Connection: Often provides output options like 

HDMI, DisplayPort, or VGA directly from the motherboard. 

Audio and Network Connectors 

Description: These connectors are used for audio and networking functions. Audio: Usually a set of 3-6 audio 

jacks for surround sound systems.  

Network:  

An Ethernet port (RJ-45) for wired network connectivity. 

USB Ports and Headers 

Description: These provide connections for external peripherals such as keyboards, mice, printers, and USB 

storage devices. 

    Types: 

• Rear I/O ports: USB 2.0, USB 3.0, USB 3.1, USB-C. 

• Internal USB headers: For front panel USB ports on the case. 
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CMOS Battery 

Description: A small battery (typically a CR2032 coin cell) that powers the motherboard's CMOS chip. It stores 

system settings (like BIOS/UEFI configurations) when the system is powered off. 

Heat Sinks and VRMs (Voltage Regulator Modules) 

Description: These are thermal management components that help dissipate heat from the CPU and power 

regulation components’: These regulate the voltage supplied to the CPU and other components to ensure stable 

power delivery. 

BIOS/UEFI Chip 

Description: The BIOS (Basic Input/Output System) or UEFI (Unified Extensible Firmware Interface) chip stores 

the firmware that controls the motherboard's hardware and allows for system configuration before booting the 

operating system. 

Front Panel Connectors 

Description: These pins connect the motherboard to the front panel of your computer case, where you can connect 

the power button, reset button, power LED, hard drive activity LED, and front USB ports. 

Heat Pipes and Cooling Solutions 

Description: In higher-end motherboards, you may find additional cooling solutions such as heat pipes or active 

cooling fans for areas like the VRMs and chipset to prevent overheating. 

 

Number System 

When we type some letters or words, the computer translates them in numbers as computers can understand 

only numbers. A computer can understand the positional number system where there are only a few symbols 

called digits and these symbols represent different values depending on the position they occupy in the number. 

The value of each digit in a number can be determined using - 

• The digit 

• The position of the digit in the number 

• The base of the number system (where the base is defined as the total number of digits available in the 

number system) 

 

 

 

Number System Base Digits 
Binary 2 0, 1 
Octal 8 0, 1, 2, 3, 4, 5, 6, 7 
Decimal 10 0, 1, 2, 3, 4, 5, 6, 7, 8, 9 

Hexadecimal 16 0, 1, 2, 3, 4, 5, 6, 7, 8, 9, 
A, B, C, D, E, F 
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I/O Devices (Input/Output Devices) 

In a computer system, I/O devices (Input/Output devices) enable interaction between the computer and the 

external world, allowing data to be input into the computer or output from the computer. These devices play a 

critical role in facilitating communication between the computer and the user or other systems. 

 

Input Devices: 

Input devices are used to send data or commands to the computer for processing. 

• Keyboard: Types text and commands 

• Mouse: Controls cursor and selects items 

• Scanner: Scans documents and images 

• Webcam: Captures video and images 
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• Microphone: Records audio 

• Touchpad/Touchscreen: Controls cursor and selects items 

• Game Controller: Controls games 

• Barcode Reader: Scans barcodes 

• RFID Reader: Reads RFID tags 

• Joystick: Controls games and simulations 

Keyboard 

Keyboard is the most common and very popular input device which helps to input data to the computer. The layout 

of the keyboard is like that of traditional typewriter, although there are some additional keys provided for 

performing additional functions. 

 

 

Mouse 

Mouse is the most popular pointing device. It is a very famous cursor-control device having a small palm size box 

with a round ball at its base, which senses the movement of the mouse and sends corresponding signals to the 

CPU when the mouse buttons are pressed. Generally, it has two buttons called the left and the right button and a 

wheel is present between the buttons. A mouse can be used to control the position of the cursor on the screen, 

but it cannot be used to enter text into the computer. 

 

Joystick 

Joystick is also a pointing device, which is used to move the cursor position on a monitor screen. It is a stick 

having a spherical ball at its both lower and upper ends. The lower spherical ball moves in a socket. The joystick 

can be moved in all four directions. The function of the joystick is similar to that of a mouse. It is mainly used in 

Computer Aided Designing (CAD) and playing computer games. 
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Light Pen 

Light pen is a pointing device similar to a pen. It is used to select a displayed menu item or draw 

pictures on the monitor screen. It consists of a photocell and an optical system placed in a small 

tube. 

Track Ball 

Track ball is an input device that is mostly used in notebook or laptop computer, instead of a mouse. This is a ball 

which is half inserted and by moving fingers on the ball, the pointer can be moved. Since the 

whole device is not moved, a track ball requires less space than a mouse. A track ball comes 

in various shapes like a ball, a button, or a square. 

Scanner 

Scanner is an input device, which works more like a photocopy machine. It is used when some information is 

available on paper and it is to be transferred to the hard disk of the computer for further manipulation. Scanner 

captures images from the source which are then converted into a digital form that can be stored on the disk. These 

images can be edited before they are printed. 

Digitizer 

Digitizer is an input device which converts analog information into digital form. Digitizer can convert a signal from 

the television or camera into a series of numbers that could be stored in a computer. 

They can be used by the computer to create a picture of whatever the camera had 

been pointed at. Digitizer is also known as Tablet or Graphics Tablet as it converts 

graphics and pictorial data into binary inputs. A graphic tablet as digitizer is used for 

fine works of drawing and image manipulation applications. 

Microphone 

Microphone is an input device to input sound that is then stored in a digital form. The microphone is used for 

various applications such as adding sound to a multimedia presentation or for mixing music. 

Magnetic Ink Card Reader (MICR) 

MICR input device is generally used in banks as there are large number of cheques to be processed every day. 

The bank's code number and cheque number are printed on the cheques with a special type of 

ink that contains particles of magnetic material that are machine readable. This reading process 

is called Magnetic Ink Character Recognition (MICR). The main advantages of MICR 

are that it is fast and less error prone. 
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Optical Character Reader (OCR) 

OCR is an input device used to read a printed text. OCR scans the text optically, character by character, converts 

them into a machine-readable code, and stores the text on the system memory. 

 

 

 

 

 

Bar Code Readers 

Bar Code Reader is a device used for reading bar coded data (data in the form of light 

and dark lines). Bar coded data is generally used in labelling goods, numbering the books, 

etc. It may be a handheld scanner or may be embedded in a stationary scanner. Bar Code 

Reader scans a bar code image, converts it into an alphanumeric value, which is then fed 

to the computer that the bar code reader is connected to. 

Optical Mark Reader (OMR) 

OMR is a special type of optical scanner used to recognize the type of mark made by pen 

or pencil. It is used where one out of a few alternatives is to be selected and marked. It is 

specially used for checking the answer sheets of examinations having multiple choice Questions. 

 

 

Output Devices: 

Output devices are used to display or present data processed by the computer to the user or other systems. 

• Monitor: Displays graphics and text 

• Speakers: Plays audio 

• Printer: Prints documents and images 

• Projector: Displays presentations and videos 

• Headphones: Plays audio 

• LED/LCD Display: Displays text and graphics 

• Plotters: Prints large-format documents 

• 3D Printer: Creates physical objects 

• Braille Display: Displays text in Braille 

• HDMI Output: Sends video and audio to external devices 
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Monitors 

Monitors, commonly called as Visual Display Unit (VDU), are the main output device of a computer. It forms 

images from tiny dots, called pixels that are arranged in a rectangular form. The sharpness of the image depends 

upon the number of pixels. 

There are two kinds of viewing screen used for monitors.  

Cathode-Ray Tube (CRT)   Flat-Panel Display 

Printers 

Printer is an output device, which is used to print information on paper. There are two types of printers: Impact 

Printers and Non-Impact Printers 

Impact Printers  

Impact printers print the characters by striking them on the ribbon, which is then pressed on the paper. Very low 

consumable costs, very noisy, Useful for bulk printing due to low cost. There is physical contact with the paper 

to produce an image. 

 

Non-impact Printers 

Non-impact printers print the characters without using the ribbon. These printers print a complete page at a time, 

thus they are also called as Page Printers. Faster than impact printers, they are not noisy, High quality, Supports 

many fonts and different character size.  

Two types of non-impact printer are their Laser Printers, Inkjet Printers 
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Computer speaker 

A computer speaker is an output device used to produce sound from a computer system. It converts digital audio 

signals from the computer into audible sound, allowing users to hear music, videos, games, notifications, or any 

other audio content generated by the computer. 

 

 

 

 

 

 

 

 

 

Software 

Software is a set of programs, designed to perform a well-defined function. A program is a sequence of instructions 

designed to solve a particular problem. There are two types of software  

• System Software 

• Application Software 

 

 

System Software 

The system software is a collection of programs designed to operate, control, and extend the processing 

capabilities of the computer itself. System software is generally prepared by the computer manufacturers. Some 

examples of system software are Operating System, Compilers, Interpreter, Assemblers, etc. 

 

 

Application Software 

Application software products are designed to satisfy a particular need of a particular environment. All software 

applications prepared in the computer lab can come under the category of Application software. Application 

software may consist of a single program, such as Microsoft's notepad for writing and editing a simple text. It may 

also consist of a collection of programs, often called a software package, which work together to accomplish a 

task, such as a spreadsheet package. Examples of Application software are Payroll Software. Student Record 
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Software, Inventory Management Software, Income Tax Software, Railways Reservation Software, Microsoft 

Office Suite Software, Microsoft Office etc. 
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Networking 

A computer network is a system in which multiple computers are connected to each other to share information 

and resources. 

 

Characteristics of a Computer Network 

Share resources from one computer to another. Create files and store them in one computer, access those   files   

from   the   other   computer(s) connected over the network. Connect a printer, scanner, or a fax machine to one 

computer within the network and let other computers of the network use the machines available over the network. 

Following is the list of hardware's required to set up a computer network. 

• Network Cables 

• Distributors 

• Routers 

• Internal Network Cards 

• External Network Cards 

 

 

 

Network Cables 

Network cables are used to connect computers. The most commonly used cable is Category 5 cable RJ-45. 
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Distributors  

A computer can be connected to another one via a serial port but if we need to connect many computers to 

produce a network, this serial connection will not work. 

Router 

A router is a type of device which acts as the central point among computers and other devices that are a part of 

the network. It is equipped with holes called ports. Computers and other devices are connected to a router using 

network cables. Now-a-days router comes in wireless modes using which computers can be connected without 

any physical cable. 

Network Card 

Network card is a necessary component of a computer without which a computer cannot be connected over a 

network. It is also known as the network adapter or Network Interface Card (NIC). Most branded computers have 

network card pre-installed. Network cards are of two types: 

Internal and External Network Cards. 

Universal Serial Bus (USB) 

USB card is easy to use and connects via USB port. Computers automatically  

detect USB card and can install the drivers required to support the USB network card automatically. 

Operating System 

The Operating System is a program with the following features: 

An operating system is a program that acts as an interface between the software and the computer hardware. It 

is an integrated set of specialized programs used to manage overall resources and operations of the computer. It 

is specialized software that controls and monitors the execution of all other programs that reside in the computer, 

including application programs and other system software. 

Objectives of Operating System 

The objectives of the operating system are - 

• To make the computer system convenient to use in an efficient manner. 

• To hide the details of the hardware resources from the users. 

• To provide users a convenient interface to use the computer system. 

• To act as an intermediary between the hardware and its users, making it easier for the users to access 

and use other resources. 

• To manage the resources of a computer system. To keep track of who is using which resource, granting 

resource requests, and mediating conflicting requests from different programs and users. 

• To provide efficient and fair sharing of resources among users and programs. 
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Characteristics of Operating System 

• Memory Management - Keeps track of the primary memory, i.e. what part of it is in use by whom, what 

part is not in use, etc. and allocates the memory when a process or program requests it. 

• Processor Management - Allocates the processor (CPU) to a process and deal locates the processor 

when it is no longer required. 

• Device Management - Keeps track of all the devices. This is also called I/O controller that decides which 

process gets the device, when, and for how much time. 

• File Management - Allocates and de-allocates the resources and decides who gets the resources. 

• Security - Prevents unauthorized access to programs and data by means of passwords and other similar 

techniques. 

• Job Accounting - Keeps track of time and resources used by various jobs and/or users. 

• Control Over System Performance - Records delays between the request for a service and from the 

system. 

• Interaction with the Operators - Interaction may take place via the console of the computer in the form of 

instructions. The Operating System acknowledges the same, does the corresponding action, and informs 

the operation by a display screen. 

• Error-detecting Aids - Production of dumps, traces, error messages, and other debugging and error- 

detecting methods. 

• Coordination between Other Software and Users - Coordination and assignment of compilers, 

interpreters, assemblers, and other software to the various users of the computer systems. 

Internet 

It is a worldwide/global system of interconnected computer networks. It uses the standard Internet Protocol 

(TCP/IP). Every computer in Internet is identified by a unique IP address. IP Address is a unique set of numbers 

(such as 110.22.33.114) which identifies a computer's location. 

 

A special computer DNS (Domain Name Server) is used to provide a name to the IP Address so that the user can 

locate a computer by a name. For example, a DNS server will resolve anamehttp://www.tutorialspoint.com to a 

particular IP address to uniquely identify the computer on which this website is hosted. 
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Intranet 

Intranet is the system in which multiple PCs are connected to each other. PCs in intranet are not available to the 

world outside the intranet. Usually, each organization has its own Intranet network and members/employees of 

that organization can access the computers in their intranet. 

Each computer in Intranet is also identified by an IP Address which is unique among the computers in that Intranet. 

 

Similarities between Internet and Intranet 

• Intranet uses the internet protocols such as TCP/IP and FTP. 

• Intranet sites are accessible via the web browser in a similar way as websites in the internet. However, 

only members of Intranet network can access intranet hosted sites. 

• In Intranet, own instant messengers can be used as similar to yahoo messenger/gtalk over the internet. 

• Internet is general to PCs all over the world whereas Intranet is specific to few PCs. 

• Internet provides a wider and better access to websites to a large population, whereas Intranet is 

restricted. 

• Internet is not as safe as Intranet. Intranet can be safely privatized as per the need. 

 

 

Summary: 

We can learn about hardware (like CPUs, RAM, and storage), software (operating systems and applications), 

networking basics, and databases. We also get familiar with programming concepts and data security. This 

foundation has also help you understand how computers work, troubleshoot issues, and make informed tech 

decisions for your business. 
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Check your Understanding: 

Question: 1 

A computer program that converts assembly language to machine language is 

a) Compile 

b) Interpreter 

c) Assembler 

d) Comparator 

Question: 2 

Which is a device that changes information into digital form? 

a) Modem 

b) Digitizer 

c) Mouse 

d) Light pen 

Question: 3 

Which memory stores the values of variables? 

a) SRAM 

b) ROM 

c) RAM 

d) PROM 

Question: 4 

Computer size was very large in 

a) First generation 

b) Second generation 

c) Third generation 

d) Fourth generation 

Question: 5 

A device used to bring information into a computer is 

a) ALU 

b) Input device 

c) Control unit 

d) Output device 
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Question: 6 

The period of second-generation computer was started from 

a) 1946-1958 

b) 1940-1960 

c) 1959-1965 

d) 1957-1964 

Question: 7 

Which initiates the loading of the operating system? 

a) RAM 

b) Hard disk 

c) ROM 

d) Pen Drive 

Question: 8 

What is the full form of POST? 

a) Power On Start Test 

b) Power On Self-Test 

c) Push On Self-Test 

d) Pulse Oriented Self-Test 

Question: 9 

The basic operations performed by a computer are 

a) Arithmetic operation 

b) Storage and relative 

c) Logical operation 

d) All the above 

Question: 10 

Which is not application software? 

a) Windows NT 

b) Page Maker 

c) WinWord XP 

d) Photoshop 
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Chapter 2:  Operating System Windows 10 
Introduction 

Windows 10 is a widely acclaimed operating system developed by Microsoft and officially released on July 29, 

2015. It marked a significant evolution in the Windows operating system series by combining the best features of 

its predecessors while introducing innovative functionalities designed for modern users. 

About Windows 10 

Windows 10 is an operating system developed by Microsoft and was first released on July 29, 2015. It was 

designed to work across a wide range of devices, including desktops, laptops, tablets, and smartphones. 

 

Key Features Windows 10: 

• Start Menu: The Start Menu was brought back in Windows 10 after being removed in Windows 8. It 

combines the traditional Start Menu with the Live Tiles from Windows 8. 

• Cortana: Windows 10 introduced Cortana, a digital assistant that helps with tasks like setting reminders, 

searching the web, and managing calendars. 

• Microsoft Edge: The web browser Microsoft Edge replaced Internet Explorer. It is faster, more secure, 

and includes features like reading mode and Cortana integration. 

• Virtual Desktops: Users can create multiple virtual desktops to better organize their workspace and switch 

between tasks more efficiently. 

• Action Center: This feature provides notifications and quick access to important settings such as Wi-Fi, 

Bluetooth, and more. 

• Windows Update: Windows 10 features automatic updates to keep the system secure and up-to-date with 

new features and patches. 

• DirectX 12: This version of DirectX is designed to improve gaming performance and enhance graphics 

processing. 

• Security Features: Features like Windows Defender, Windows Hello (biometric security), and BitLocker 

provide added security. 

• Compatibility: Windows 10 was built to run a wide variety of applications and software from previous 

versions of Windows, making it highly compatible. 

• Windows Store: The Microsoft Store allows users to download apps, games, music, and movies from a 

central location. 
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Editions of Windows 10: 

• Windows 10 Home: Aimed at consumers, this edition provides basic functionality. 

• Windows 10 Pro: Includes additional features for business users, such as BitLocker, Hyper-V, and the 

ability to join a domain. 

• Windows 10 Enterprise: Offers advanced features for IT professionals in large organizations. 

• Windows 10 Education: Similar to Enterprise but for educational institutions. 

• Windows 10 Mobile: A version designed for smartphones (though largely phased out). 

 

An operating system manages all of the hardware and software on a computer. Without it, the computer would be 

useless. To learn more about how operating systems work, check out Understanding Operating Systems and 

Getting to Know the OS in our Computer Basics tutorial.  

 

Start menu 

Windows 8 uses the Start screen to launch applications, Windows 10 has reintroduced a more traditional Start 

menu. It's also been expanded to make it easier to find important apps. 
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Microsoft Edge 

This new browser is designed to give Windows users a better experience on 

the Web. It's faster, more secure, and includes a lot of new features. Microsoft 

Edge is meant to replace Internet Explorer as your default web browser, but 

you'll still be able to use another browser if you prefer. 

 

Cortana 

Similar to Google Now, you can talk to this virtual assistant with your computer's microphone. Cortana can answer 

Questions like what's the weather like today. 

Multiple desktops and Task view 

Instead of keeping everything open on the same desktop, you can move some of your windows to a virtual desktop 

to get them out of the way. And the new Task view feature makes it easy to manage all of your open windows. 

Action Center 

The new Action Centre is pretty different from previous versions of Windows. For example, it's been expanded to 

let you access frequently used settings, such as Wi-Fi connectivity and tablet mode. It's also where you'll see 

important notifications, so if your computer receives an update, you'll get a notification about it here. 

Tablet mode 

Unlike Windows 8, Windows 10 makes a clear distinction between desktops and tablets. If you're using a keyboard 

and mouse with Windows 10, you'll be in desktop mode by default. If your computer also has a touchscreen, you 

can go into tablet mode at any time. Tablet users can also switch back to desktop mode. 
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Getting started with Windows 10 

Navigating the desktop 

Once you've signed in, the first thing you'll see is the desktop. You can think of the desktop as the main workspace 

for your computer. From here, you can view and manage your files, open applications, access the Internet, and 

much more. 

Opening applications 

You'll use the Start menu to open programs on your computer, just like with previous versions of Windows. To do 

this, click the Start button in the bottom-left corner, then choose the desired application. If you don't see the one 

you want, you can scroll to see a full list of applications. In the example below, we're opening One Note. 

Working with files 

You'll use the File Explorer to manage your files and folders. To open File Explorer, click the File Explorer icon on 

the taskbar or double-click any folder on your desktop. 

Searching for files and apps 

To search for something on your computer—like a specific file or application—click the Search Box, then start 

typing. In the example below, we're searching for a Microsoft Word document. 

Adjusting your settings 

You'll use the Settings app to change the most important settings on your computer, like your network and display 

options. To open the app, click the Start menu, then select Settings. You can also use the Control Panel to adjust 

your settings, just like in earlier versions of Windows. However, there are some options that can only be accessed 

from the Settings app, like adding a new user. 

Shutting down your computer 

When you're done using your computer, it's important to shut it down properly. To do this, click the Start button, 

then choose Power > Shut Down. 

Tips for managing multiple windows 

Windows 10 has several features that make it easier to multi-task and work with multiple windows at the same 

time. 

Snap 

Snap allows you to resize windows quickly, which is especially convenient when you want to see two windows 

side by side. To do this, click and drag the desired window to the left or right until the cursor reaches the edge of 

the screen, then release the mouse. The window will snap into place. To unsnap a window, simply click and drag 

the window down. 
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Flip 

You can use Flip to switch between open windows. To do this, press and hold the Alt key on your keyboard, then 

press the Tab key. Continue pressing the Tab key until the desired window is selected. 

Task view 

The Task view feature is similar to Flip, but it works a bit differently. To open Task view, click the Task view button 

near the bottom-left corner of the taskbar. Alternative, you can press Windows key+Tab on your keyboard. All of 

your open windows will appear, and you can click to choose any window you want. 

 

 

Summary: 

Now, we can see in Windows 10 is a User-Friendly Interface, Performance and Speed, Regular Updates, Wide 

Compatibility and supports a vast range of software, from legacy Windows applications to modern UWP apps. 

Windows 10 offers a range of personalization options, from themes to customizable taskbars. 
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Check your understandings 

Question: 1 

Which of the following is not an operating system? 

a) Windows 

b) Linux 

c) Oracle 

d) DOS 

Question: 2 

When was the first operating system developed? 

a) 1948 

b) 1949 

c) 1950 

d) 1951 

Question: 3 

Which of the following is the extension of Notepad? 

a) .txt 

b) .xls 

c) .ppt 

d) .bmp 

Question: 4 

What is the full name of FAT? 

a) File attribute table 

b) File allocation table 

c) Font attribute table 

d) Format allocation table 

Question: 5 

What is the mean of the Booting in the operating system? 

a) Restarting computer 

b) Install the program 

c) To scan 

d) To turn off 
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Question: 6 

When you delete a file in your computer, where does it go? 

a) Recycle bin 

b) Hard disk 

c) Taskbar 

d) None of these 

Question: 7 

Which of the following is a single-user operating system? 

a) Windows 

b) MAC 

c) Ms-Dos 

d) None of these 

Question: 8 

Which of the following is not application software? 

a) Windows 7 

b) WordPad 

c) Photoshop 

d) MS-excel 

Question: 9 

Which of the following windows does not have a start button? 

a) Windows 7 

b) Windows 8 

c) Windows XP 

d) None of these 

Question: 10 

What is Microsoft window? 

a) Operating system 

b) Graphics program 

c) Word Processing 

d) Database program 
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Chapter 3:   Microsoft Word 2016 
Introduction 

Microsoft Word is one of the most widely used word processing applications in the world, developed by Microsoft 

as part of its Office suite. As a flagship product in Microsoft Office, Word offers an intuitive interface and a 

comprehensive set of features that cater to a wide range of users, including students, professionals, and 

businesses. With integrated tools for spell check, grammar suggestions, and templates, Word simplifies the 

process of creating polished and professional documents. The software also supports collaborative editing, 

allowing multiple users to work on a document simultaneously. 

History 

Microsoft Word 2016 is a word processing application that allows you to create a document, including letters, 

resumes, and more. Microsoft Word 2016 has some most important features, such as the Ribbon, Quick Access 

Toolbar, and Backstage view. Word 2016 has a user-friendly interface and wide range of formatting options. 

Word 2016 is similar to Word 2013 and Word 2010. If you've previously used either version, then Word 2016 

should feel familiar. But if you are new to Word or have more experience with older versions, you should first take 

some time to become familiar with the Word 2016 interface. 

 

Working with the Word environment 

Microsoft Word 2016 continues to use features like the Ribbon and the Quick Access Toolbar—where you will find 

commands to perform common tasks in Word—as well as Backstage view. The Ribbon contains multiple tabs, 

which you can find near the top of the Word window. Each tab contains several groups of related commands. For 

example, the Font group on the Home tab contains commands for formatting text in your document. 

The Ribbon Word uses a tabbed Ribbon system instead of traditional menus. The Ribbon contains multiple tabs, 

which you can find near the top of the Word window.  

Each tab contains several groups of related commands. For example, the Font group on the Home tab contains 

commands for formatting text in your document. Some groups also have a small arrow in the bottom-right corner 

that you can click for even more options. If you find that the Ribbon takes up too much screen space, you can 
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hide it. To do this, click the Ribbon Display Options arrow in the upper-right corner of the Ribbon, then select the 

desired option from the drop-down menu: 

The Quick Access Toolbar 

Located just above the Ribbon, the Quick Access Toolbar lets you access common commands no matter which 

tab is selected. By default, it shows the Save, Undo, and Redo commands, but you can add other commands 

depending on your needs. 

 

Backstage view 

Backstage view gives you various options for saving, opening a file, printing, and sharing your document. To 

access Backstage view, click the File tab on the Ribbon. 

In Microsoft Word 2016, the ribbon is organized into tabs, each of which contains a collection of tools to help you 

perform specific tasks. Below is a detailed overview of each tab and the key tools you can find within them. 

In Microsoft Word 2016, there are 9 main tabs on the ribbon,each with its own set of tools and commands. Here’s 

a breakdown of the main tabs: 

 

 1. File Tab (Backstage View) 

➢ New: Create a new document. 

➢ Open: Open an existing document from your computer or cloud storage. 

➢ Save: Save the current document. 

➢ Save As: Save the document with a new name or location. 

➢ Print: Open the print dialog to print the document. 

➢ Share: Share the document via email, OneDrive, or other options. 

➢ Export: Export the document to different formats (PDF, XPS). 

➢ Close: Close the current document. 

➢ Account: Manage your Microsoft account, product information, and updates. 

➢ Options: Access Word settings for customization and preferences. 
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 2. Home Tab 

This tab is the most frequently used and contains the basic tools for text formatting and paragraph adjustments. 

  

Clipboard: 

➢ Cut: Remove selected text or object. 

➢ Copy: Copy the selected text or object. 

➢ Paste: Paste the contents of the clipboard into your document. 

➢ Format Painter: Copy the formatting from selected text and apply it elsewhere. 

   Font: 

➢ Font Style: Change font type (e.g., Arial, Times New Roman). 

➢ Font Size: Adjust the font size. 

➢ Bold: Make text bold. 

➢ Italic: Make text italicized. 

➢ Underline: Underline the selected text. 

➢ Strikethrough: Cross out text with a line. 

➢ Subscript/Superscript: Adjust the text position (subscript: below, superscript: above). 

➢ Text Highlight Color: Highlight text with color. 

➢ Font Color: Change text color. 

➢ Text Effects: Apply effects like shadow, reflection, glow, etc. 
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 Paragraph: 

➢ Align Left, Center, Align Right, Justify: Adjust the alignment of the text. 

➢ Line and Paragraph Spacing: Adjust space between lines or paragraphs. 

➢ Shading: Apply background color to paragraphs. 

➢ Borders: Add or remove borders from paragraphs. 

➢ Bullets and Numbering: Create bulleted or numbered lists. 

➢ Increase/Decrease Indent: Adjust paragraph indentation. 

➢ Sort: Sort text alphabetically or numerically. 

➢ Find: Open the "Find" dialog to search for specific text. 

➢ Replace: Replace specific text with another. 

 Styles: 

➢ Quick Styles: Apply predefined text styles (e.g., Heading 1, Heading 2, Normal). 

➢ Change Styles: Modify document styles or create custom styles. 

Editing: 

➢ Find: Search for specific text. 

➢ Replace: Search and replace text. 

➢ Select: Select all or specific parts of the document. 

 3. Insert Tab 

The Insert tab provides tools for adding various elements to your document. 

 

 Pages: 

➢ Cover Page: Insert a predesigned cover page. 

➢ Blank Page: Insert a blank page at the current cursor position. 

➢ Page Break: Start a new page at the cursor’s location. 

➢  Tables: Insert a table, draw a table, or use a predefined table design. 

 Illustrations: 

➢ Pictures: Insert images from your device or online. 

➢ Shapes: Insert predefined shapes (e.g., circles, arrows, lines). 

➢ Icons: Add vector-based icons. 

➢ SmartArt: Insert diagrams for visualizing information. 

➢ Chart: Insert a chart to display data. 

➢ Screenshot: Take a screenshot of another open window. 
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Links: 

➢ Hyperlink: Insert or edit hyperlinks. 

➢ Bookmark: Add a bookmark to a specific place in the document. 

➢ Cross-reference: Insert references to other parts of the document. 

Text: 

➢ Text Box: Insert a text box. 

➢ Quick Parts: Insert reusable content such as headers, footers, and autotext. 

➢ WordArt: Add decorative text. 

➢ Signature Line: Insert a line for a signature. 

➢ Date & Time: Insert the current date or time. 

➢ Object: Insert an embedded file or object. 

Symbols: Insert special characters, symbols, or equation formulas. 

 4. Design Tab 

The Design tab provides tools to control the visual layout of your document. 

Document Formatting: 

➢ Themes: Change the overall look of the document with predefined themes. 

➢ Colors: Change the color scheme of the document. 

➢ Fonts: Choose a font style for the entire document. 

➢ Effects: Apply visual effects such as shadows, reflections, etc. 

   Page Background: 

➢ Watermark: Insert a watermark to appear behind text (e.g., "Confidential"). 

➢ Page Color: Change the background color of the page. 

➢ Borders: Add or remove page borders. 

➢ Page Color: Apply color to the background of the page. 

 5. Layout Tab 

The Layout tab provides tools for adjusting the layout of your document, such as margins, spacing, and orientation. 
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Page Setup: 

➢ Margins: Set custom margins or choose from predefined options. 

➢ Orientation: Switch between Portrait and Landscape mode. 

➢ Size: Set page size (e.g., A4, Letter). 

➢ Columns: Create multicolumn layouts. 

Paragraph: 

➢ Indentation: Adjust the left or right indent. 

➢ Spacing: Set spacing before or after paragraphs. 

Arrange: 

➢ Position: Adjust the position of objects on the page (e.g., text wrapping around an image). 

➢ Bring Forward / Send Backward: Adjust the stacking order of objects. 

➢ Group: Group multiple objects together. 

6. References Tab 

 

The References tab is mainly used for academic or research papers. 

➢ Table of Contents: Automatically create a table of contents. 

➢ Footnotes: Insert footnotes or endnotes. 

➢ Citations & Bibliography: Manage references, insert citations, and generate a bibliography. 

➢ Captions: Add captions to images, tables, and figures. 

➢ Index: Insert an index based on your document's content. 

➢ Table of Authorities: Insert a legal style table of authorities. 

 7. Mailings Tab 

 

The Mailings tab is used for creating and managing mail merges. 

Create: 

➢ Start Mail Merge: Create letters, envelopes, labels, etc. 

➢ Select Recipients: Choose the recipients for your mail merge. 

➢ Insert Merge Fields: Insert fields from your data source into your document. 
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 Write & Insert Fields: 

➢ Address Block: Insert an address block into a letter. 

➢ Greeting Line: Insert a personalized greeting. 

Preview Results: View how the merged document will look. 

Finish: Complete the mail merge and print or save the documents. 

8. Review 

 

This tab provides tools for reviewing and editing your document, including spelling and grammar checking, adding 

comments, tracking changes, comparing documents, and protecting documents. 

The Review tab includes tools for reviewing and editing documents. 

Proofing: 

➢ Spelling & Grammar: Check for spelling and grammar mistakes. 

➢ Thesaurus: Find synonyms for selected words. 

➢ Word Count: Count words, characters, and other statistics. 

 Comments: 

➢ New Comment: Add a comment to the document. 

➢ Delete: Delete a comment. 

➢ Previous/Next: Navigate through comments. 

 Tracking: 

➢ Track Changes: Turn on Track Changes to mark edits. 

➢ Accept/Reject: Accept or reject changes made to the document. 

  Changes: 

➢ Compare: Compare two versions of a document. 

➢ Protect: Restrict editing permissions on the document. 
 

9. View Tab 

 

The View tab provides tools for adjusting the layout and view settings of your document. 
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 Views: 

➢ Print Layout: View the document as it will appear when printed. 

➢ Web Layout: View the document as a web page. 

➢ Outline: View the document as an outline. 

➢ Draft: View the document in draft mode. 

  Show: 

➢ Ruler: Display or hide the ruler for measuring and alignment. 

➢ Gridlines: Display or hide gridlines for positioning objects. 

  Zoom: 

➢ Zoom: Change the zoom level for better viewing. 

➢ One Page / Multiple Pages: View one or multiple pages at once. 

Additional Tabs: 

There are also contextual tabs that appear when you perform certain actions or select certain objects (such as 

tables, pictures, charts, etc.). These tabs provide specific tools related to that object. For example: 

• Table Tools: Appears when you select a table, with tools for table design and layout. 

• Picture Tools: Appears when you select a picture, with tools for adjusting the image and applying effects. 

• Drawing Tools: Appears when you select a shape or drawing. 
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Open Microsoft Word & Start Typing 

Open Microsoft Word by clicking on the Word icon in your Start menu or taskbar. 

Start typing to create your document. Word automatically adjusts text formatting as you type, but you can 

customize the style using the Home tab for font styles, sizes, and alignments. 

Save Your Document Regularly 

Press Ctrl+S to Save your document regularly. 

Save As: If you want to save the document with a new name or format, click on File > Save As. 

AutoSave: If you’re using OneDrive or SharePoint, you can enable AutoSave for continuous saving. 

 

Use Keyboard Shortcuts 

• Ctrl+N: Create a new document. 

• Ctrl+P: Open the Print menu. 

• Ctrl+Z: Undo last action. 

• Ctrl+Y: Redo last action. 

• Ctrl+F: Open the Find dialog. 

• Ctrl+H: Open the Replace dialog. 

• Ctrl+B: Apply or remove bold. 

• Ctrl+I: Apply or remove italics. 

• Ctrl+U: Apply or remove underline. 

Summary of Microsoft Word 2016 

We have highlighted the key points for getting started with Microsoft Word and optimizing its features for efficient 

document creation. Open Microsoft Word and start typing and formatting text. Insert images, tables, and other 

multimedia. 
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Check your understanding  

Question 1 

Which is not shown under Microsoft Word toolbar? 

a) Italic 

b) Font 

c) Bold 

d) Magic tool 

Question 2 

What is the blank space outside the printing area on a page? 

a) Margins 

b) Clipart 

c) Footer 

d) Header 

Question 3 

Select all the text in MS Word document by 

a) Ctrl + S 

b) Ctrl + A 

c) Ctrl + V 

d) Ctrl + 1 

Question 4 

Ctrl + I command is used for what purpose? 

a) Save Document 

b) Left Indent 

c) Italic 

d) Close Document 

Question 5 

Which of the following tools can be used in MS Word? 

a) Hyperlinks 

b) Bullets 

c) Highlight 

d) All of the above 
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Question 6 

What is the function of the spelling and grammar tool? 

a) Corrects Spelling Errors as You Type 

b) Indicates Grammatical Errors 

c) Identifies Words with Capitalization Problems 

d) All Of Above 

Question 7 

Formatting is performed on 

a) Table 

b) Text 

c) Menu 

Question 8 

What is landscape? 

a) Page Orientation 

b) Paper Size 

c) A Font Style 

d) Page Layout 

Question 9 

Shortcut key for “Subscript” is? 

a) Ctrl + Shift + – 

b) Ctrl + Shift + = 

c) Ctrl + = 

d) Ctrl + – 

Question 10 

What is the default file extension for all MS Word documents? 

a) .word 

b) .docx 

c) .docs 
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Chapter 4:   Microsoft Excel 2016 
Introduction 

Microsoft Excel 2016 effectively can help you harness its powerful features for managing data, performing 

calculations, creating charts, and analysing information. Below are key learning utilities and tools within Excel 

2016, along with helpful tips to get started and improve your skills. 

• Practice Regularly: The more you use Excel, the more comfortable you will become. Try to use Excel to 

solve real-world problems like budgeting, data analysis, or project planning. 

• Start with Templates: Use Excel’s built-in templates to get familiar with common document types and their 

formatting. 

• Experiment with Functions: Start experimenting with simple functions like SUM, AVERAGE, and IF to 

build your understanding of how Excel works. 

• Use Conditional Formatting and Charts: Make your data visually appealing and easier to interpret. 

• Explore Advanced Features: Once you're comfortable with the basics, explore more advanced tools like 

PivotTables, Power Query, and Macros. 
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Spreadsheet 

Microsoft Excel 2016 is a powerful spreadsheet program developed by Microsoft. It is a part of the Microsoft Office 

suite of productivity tools and is widely used for organizing, analyzing, and visualizing data. Excel 2016 provides 

a range of features and functions that enable users to perform complex calculations, create charts and graphs, 

manage data. We can prepare a budget, forecast sales data, create profit and loss statements etc. on an electronic 

spreadsheet faster and more accurately. 

 

 

 

 

Column and Row: 

The horizontal bar across the top of the worksheet area is filled with letters, beginning with A. Each letter 

represents a column while the vertical bar on the left side of the worksheet filled with numbers refers to rows. 

 

 



 

C D T A  P a g e  54 | 111 

 

Youth Computer Training Centre 

Cell 

The intersection between a column and a row is referred to as a cell. A cell is similar to a box that can be used to 

store pieces of information. Each piece of information could be a word or group of words, number or a 

mathematical formula. 

Cell Address 

Cell has its own address which the identifies the location of each cell. This address is used in formula for 

referencing the cell of the Worksheet. The address of a cell is defined by the letter of the column in which it is 

located and the Number of the row. For example, in column B, row 5 would be referred to as B5.  

Workbooks and Worksheet 

An Excel workbook is a file also known as spreadsheet. It serves as a container for organizing and storing data 

in a structured manner. A workbook consists of one or more worksheets, which are individual tabs within the 

workbook where you can enter and manipulate data. At the bottom of the worksheet is a set of small Tabs that 

identify each sheet in the workbook. 
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The operators in Excel uses for formulas: Operator (Key) Function 

= Begins all Excel functions and formulas 

+ Addition 

- Subtraction 

* Multiplication 

/ Division 

AutoSum Function 

The most common formula in Excel is SUM. We could create a formula i.e. =C6+D6+E6+F6+G6+H6. We have to 

type a lot, instead of, we can use the SUM function to do the same 

Printing a Worksheet 

To Print, Preview and Modify Page Setup 

• Click on the File tab 

• Click on Print 

Page Setup 

You can setup the following options under page setup 

Page 

• Change the Orientation 

• Adjust the Scaling 

• Change the Paper Size 
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Margins 

• Change the margins 

• Center on the page either horizontally, vertically or select both 

 

Header/Footer: 

On the Insert tab, in the Text group, click Header & Footer. Excel displays the worksheet in Page Layout view. To 

add or edit a header or footer, click the left, center, or right header or footer text box at the top or the bottom of 

the worksheet page (under Header, or above Footer). Type the new header or footer text. 

 

 

 

 

Home Tab:- Home tab contains the most frequently used options such as cut-copy-paste, font formatting, 

alignment, Number, Conditional formatting, etc. 

Clipboard: – This group contains frequently used commands i.e. Cut, Copy, Paste and Format painter. Clipboard 

option allows us to collect text and graphic items and paste it. 

Font: – This option helps to change the font style and font-size. We can make it bold, italic and underline. Also, 

this group contains border styles, fill color, font color. 

Alignment: – This option helps to change the alignment of cell's text to the right, left and middle. we can subject 

the text to top, bottom, and middle alignment. We can use wrap text option also. 

Number: – This option helps to change the number formatting into General, Percentage, Currency, Date, Time, 

Fraction etc. We can increase and decrease the decimal point and also convert the number into accounting 

number. 

Styles: – This option helps for conditional Formatting, Format as Table and Cell Styles. Format as table is having 

readymade table format and Cell styles feature different types of built-in styles that are a combination of Font 

style, Font colour and Fill colour. 
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Cells: – This option helps to insert or delete cells, rows, columns and sheets. We can also adjust the height, width 

of cells or range. This option also helps to hide or unhide the range, protect the workbook, rename the sheet 

name, fill the tab colour, move or copy to sheets, lock the cells. 

 Editing: – This option helps to apply Auto Sum feature to return the total, Clear the format, content, comments 

and hyperlink. We can also apply sort and find option. 

Insert Tab 

We use Insert tab to insert the picture, charts, filter, hyperlink etc. We use this option to insert the objects in Excel. 

To open the insert tab, press shortcut keys Alt + N. 

 

Tables: - This option helps us to insert the dynamic table, Pivot table and recommended table. 

Illustration: - We use this option to insert the Pictures, Online Pictures, Shapes, SmartArt and Screenshot. It 

means if we want to insert any image, we can use Illustration feature. 

Add-ins: - The Add-ins are the software components; that inserts enhances new features in the  Microsoft Excel. 

Charts: -Charts is very important and useful in Excel. In Excel we have different and good numbers of readymade 

chart options. Column, Bar, Radar, Line, Area, Combo, Pie and Bubbles chart. 

Reports: -We use this option to create a better report on the basis of the decisions we take for business. It makes 

the report more interactive and decipherable. 

Sparkline's: - Sparkline is a very tricky and useful option. It can visualize the trends in a single cell as charts. 

Filters: - This option to filter data visually and filter dates interactively. We have 2 options: Slicers and Timeline. 

We use Slicer to make the fast and easier to filter tables, Pivot tables, Pivot Charts and cube functions. Timeline 

makes it faster and easier to select time periods in order to filter Pivot Tables, Pivot Charts and Cube function. 

Text: - This option helps to insert the Text box, Header and Footer, Word art, Signature and objects. We use 

Header and Footer options to place the content on the top and bottom of the page. We can use word art makes 

the text stylish. 

Symbols: - This option helps to insert the symbols and equation. We use equation for common mathematical 

equations. We use Symbols to insert the symbols which are not on the keyboard. 

Page Layout 

Page layout option control how the spreadsheet will look when printed. This includes options such as adjusting 

margins, orientation, scaling, headers and footers etc. 
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In the "Page Setup" group, we have various options to customize the page layout. 

 

Margins: 

This option helps to select predefined margin sizes or choose "Custom Margins" to set your own margin values. 

Orientation: 

This helps to use the "Orientation" buttons to switch between portrait (vertical) and landscape (horizontal) 

orientations. 

Scaling: 

The scaling of the printed content using the "Scale to Fit" options. On the "Sheet Options" button to show or hide 

certain elements when printing, such as gridlines, headings, and more. 

 Print Titles: 

The "Print Titles" button use to define specific rows or columns that should appear on every printed page. 

Breaks: 

The "Breaks" button allows to insert manual page breaks or reset automatic page breaks. 

Background: 

This option helps to set a background image or color to the printed pages using the "Background" button. 

Themes: 

This option helps to apply predefined themes that you can apply to change the overall look of your spreadsheet 

when printed. Additionally, you can set headers and footers that will appear on each page of your printed 

spreadsheet. 

Formulas and Functions. 

There are two basic ways to perform calculations in Excel:  [ Formulas and Functions ] 

• Formulas 

In Excel, a formula is an expression that operates on values in a range of cells or a cell. For example, 

=A1+A2+A3, which finds the sum of the range of values from cell A1 to cell A3. 

• Functions 

Functions are predefined formulas in Excel. They eliminate laborious manual entry of formulas while giving them 

human-friendly names. For example: =SUM(A1:A3). The function sums all the values from A1 to A3. 
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Different elements in excel formula 

• Constants - numbers or text values that you enter directly in a formula, like =2*3. 

• Cell references - reference to a cell containing the value you want to use in your Excel formula, e.g. 

=SUM(A1, A2, B5).To refer to data in two or more contiguous cells, use a range reference like A1:A5. For example, 

to sum values in all cell between A1 and A5, inclusive, use this formula =SUM(A1:A5). 

• Names - defined name for a cell range, constant, table, or function, for example =SUM(my_name). 

• Functions - predefined formulas in Excel that perform calculations using the values supplied in their 

arguments. 

• Operators - special symbols that specify the type of operation or calculation to be performed. 

Cell references 

There are three types of cell references in Excel. Absolute ($A$1), relative (A1) and mixed ($A1 or A$1). All three 

of the above references refer to the same cell, and the dollar sign ($) is used only for one purpose - it tells Microsoft 

Excel whether to change or not to change cell references when the formula is moved or copied to other cells. 

 

Absolute cell reference ($A$1) - the $ sign before the row and column coordinates makes a reference static, and 

lets you copy a formula without changing references. 

 

Relative cell reference (A1) - a cell reference with no $ sign changes based on relative position of rows and 

columns in a spreadsheet. 

Mixed cell reference - can be of 2 types: 

Absolute column and relative row ($A1) - the $ sign in front of the column letter locks the reference to the 

specified column, so the column never changes. The relative row reference, without the dollar sign, changes 

depending on the row to which the formula is copied. 
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Relative column and absolute row (A$1) - the row's reference locked by $ doesn't change, and the column's 

reference does. 

 

Operators in Excel worksheet formulas 

To tell Microsoft Excel what type of operation you want to perform in a formula, you use special symbols that are 

technically called operators. There exist 4 types of operators in Excel: 

Arithmetic - to perform basic mathematical operations. 

Comparison (logical) - to compare values. 

Concatenation - to join text values into a single string. 

Reference - to make ranges and separate arguments in Excel functions. 

Using arithmetic operators in Excel formulas 

These operators are used to perform basic mathematical operations such as addition, subtraction, multiplication, 

and division. For example, if you have an item price in cell A2 and VAT in cell B2, you can calculate the VAT 

amount by using the following percentage formula: =A2*B2 

 

Operator Table  

Operator Meaning Formula example 

+ (plus sign) Addition =A2+B2 

- (minus sign) Subtraction 
Negation (reversing the sign) 

=A2-B2 
=-A2 (changes the sign of the value 
in A2) 

* (asterisk) Multiplication =A2*B2 

/ (forward slash) Division =A2/B2 

% (percent sign) Percentage =A2*10% (returns 10% of the value 
in A2) 

^ (caret) Exponential (power of) =A2^3 (raises the number in A2 to the 
power of 3) 

Comparison/ logical operators in Excel formulas 

In Microsoft Excel formulas, comparison, or logical, operators are used to compare two values. The result of the 

comparison is always a logical value of TRUE or FALSE. 
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Comparison operator Meaning Formula example 

= Equal to =A2=B2 

<> Not equal to =A2<>B2 

> Greater than =A2>B2 

< Less than =A2<B2 

>= 
<= 

Greater than or equal to 
Less than or equal to 

=A2>=B2 
=A2<=B2 

 

FORMULAS IN EXCEL 

In Microsoft Excel 2016, formulas are essential for performing calculations, manipulating data, and analysing 

information. Here's a comprehensive guide to the most common formulas and functions in Excel 2016: 

1. Basic Arithmetic Formulas 

These are simple formulas that involve basic mathematical operations. 

Addition: =A1 + B1 

Adds the values in cells A1 and B1. 

Subtraction: =A1 - B1 

Subtracts the value in B1 from A1. 

Multiplication: =A1 * B1 

Multiplies the values in A1 and B1. 

Division: =A1 / B1 

Divides the value in A1 by the value in B1. 

Exponentiation: =A1^B1 

Raises the value in A1 to the power of B1. 

2. Common Excel Functions 

a. Mathematical Functions 

These functions are used for calculations and working with numbers. 

SUM: Adds a range of numbers. 

=SUM(A1:A10) 

Adds all values from A1 to A10. 

AVERAGE: Returns the average (mean) of a range of numbers. =AVERAGE(A1:A10) 

Finds the average of values from A1 to A10. 
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MIN: Finds the smallest number in a range. 

=MIN(A1:A10) 

Returns the smallest value from the range. 

MAX: Finds the largest number in a range. 

=MAX(A1:A10) 

Returns the largest value from the range. 

COUNT: Counts the number of cells that contain numbers. 

=COUNT(A1:A10) 

Counts how many cells in the range A1 contain numeric data. 

COUNTA: Counts the number of non-empty cells. 

=COUNTA(A1:A10) 

Counts how many cells in the range A1 are not empty. 

ROUND: Rounds a number to a specified number of digits. 

=ROUND(A1, 2) 

Rounds the value in A1 to 2 decimal places. 

b. Logical Functions 

Logical functions return values based on whether a condition is true or false. 

=IF(A1 > 10, "Yes", "No") 

If the value in A1 is greater than 10, the formula returns "Yes". Otherwise, it returns "No". 

AND: Returns TRUE if all conditions are true, otherwise returns FALSE. 

=AND(A1 > 10, B1 < 5) 

Returns TRUE if both conditions are true. 

OR: Returns TRUE if at least one condition is true. 

=OR(A1 > 10, B1 < 5) 

Returns TRUE if either condition is true. 

NOT: Reverses the logic of a condition. 

=NOT(A1 > 10) 

Returns TRUE if the value in A1 is not greater than 10. 
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c. Lookup and Reference Functions 

These functions help to find values in a range or table. 

VLOOKUP: Looks for a value in the first column of a range and returns a value in the same row from another 

column. 

=VLOOKUP(D1, A1:B10, 2, FALSE) 

Looks for the value in D1 in the first column (A1) and returns the corresponding value from second column (B1). 

HLOOKUP: Similar to VLOOKUP but searches for values in rows instead of columns. 

=HLOOKUP(D1, A1:B10, 2, FALSE) 

Looks for the value in D1 in the first row (A1) and returns the corresponding value from the second row. 

INDEX: Returns a value from a range based on a specified row and column. 

=INDEX(A1:C10, 2, 3) 

Returns the value from the second row and third column in the range A1 

.MATCH: Returns the position of a value in a range. 

=MATCH("Apple", A1:A10, 0) 

Returns the position of "Apple" in the range A1 

INDIRECT: Returns a reference specified by a text string. 

=INDIRECT("A" & 1) 

Returns the value in cell A1. 

d. Text Functions 

Text functions allow you to manipulate and format text strings. 

CONCATENATE (or CONCAT in later versions): Joins two or more text strings into one. 

=CONCATENATE(A1, " ", B1) 

Joins the text in A1 and B1 with a space between them. 

LEFT: Extracts a given number of characters from the start of a text string. 

=LEFT(A1, 5) 

Returns the first 5 characters from the value in A1. 

RIGHT: Extracts a given number of characters from the end of a text string. 

=RIGHT(A1, 3) 

Returns the last 3 characters from the value in A1. 
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MID: Extracts a specific number of characters from a text string, starting at a specific position. 

=MID(A1, 2, 4) 

Returns 4 characters from the value in A1, starting at the second character. 

LEN: Returns the number of characters in a text string. 

=LEN(A1) 

Returns the number of characters in the value in A1. 

UPPER: Converts text to uppercase. 

=UPPER(A1) 

Converts the text in A1 to uppercase. 

LOWER: Converts text to lowercase. 

=LOWER(A1) 

Converts the text in A1 to lowercase. 

TRIM: Removes extra spaces from text (except for single spaces between words). 

=TRIM(A1) 

Removes any leading, trailing, or double spaces from the text in A1. 

e. Date and Time Functions 

These functions deal with dates and times in Excel. 

TODAY: Returns the current date. 

=TODAY() 

Displays today's date. 

NOW: Returns the current date and time. 

=NOW() 

Displays the current date and time. 

DATE: Returns a date based on year, month, and day. 

=DATE(2024, 12, 25) 

Returns the date December 25, 2024. 

YEAR: Extracts the year from a date. 

=YEAR(A1) 

Returns the year from the date in A1. 
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MONTH: Extracts the month from a date. 

=MONTH(A1) 

Returns the month from the date in A1. 

DAY: Extracts the day from a date. 

=DAY(A1) 

Returns the day from the date in A1. 

DATEDIF: Calculates the difference between two dates in years, months, or days. 

=DATEDIF(A1, B1, "d") 

Returns the difference between the dates in A1 and B1 in days. 

f. Financial Functions 

These functions are useful for financial calculations, such as loans or investments. 

PMT: Calculates the payment for a loan based on constant payments and a constant interest rate. 

=PMT(rate, nper, pv) 

• Calculates the monthly payment for a loan where: 

• rate is the interest rate per period. 

• nper is the number of periods. 

• pv is the present value (loan amount). 

FV: Calculates the future value of an investment. 

• =FV(rate, nper, pmt, [pv], [type]) 

Returns the future value of an investment based on constant payments and a constant interest rate. 

DATA TAB 

Data Tools 

Text to Columns – This option helps to Displays the "Convert Text to Columns Wizard" dialog box. 

Flash Fill – This option helps to automatically fills in values. 

Remove Duplicates - This option helps to Remove Duplicates. 

Data Validation - This option helps to apply data validation rules. 

Consolidate - This option helps to apply Consolidate option. 

Relationships - This option helps to create or edit relationships between the tables 
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Manage Data Model –  

This option helps to Opens the Power Pivot window. You need to enable the Data Analysis add-ins to enable this 

feature. 

Forecast 

What-If Analysis - This option helps to Scenario Manager; Goal Seek and Data Table. 

 

Forecast Sheet - This option helps to forecast your timeline data. 

 

 

 

Outline 

You can quickly display the "Settings" dialog box, by clicking on the dialog box launcher in the bottom right corner 

of this group. 

Group - This option helps to group a selection of rows and columns. Also ungroup - option helps to remove the 

outlines from the current rows and columns. line. 

Subtotal - This option helps to insert subtotals for the selected rows. Show Detail - This option helps to Expand 

a collapsed group of cells. Hide Detail - This option helps to Collapse a group of cells. 

 

Analysis 

This group will be only be displayed if you have either the Analysis-ToolPak add-in or the Solver add-in loaded. 

Data Analysis - This options helps to create the Data Analysis 

 

Solver - This option helps to apply Solver. 

 

 

Sort 

Select any cell in the data range. On the Data tab, in the Sort & Filter group, 

Picture as below mentioned…. 
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Filter 

Select any cell within the range. Select Data > Filter. Select Text Filters or Number Filters, and then select a 

comparison, like between. Enter the filter criteria and select OK. 

 

Advanced filter in Excel 

To create an advanced filter. Organize the source data. Each column has a unique heading; duplicate headings 

will cause confusion to Advanced Filter. Blank rows are not allowed within the data set. Sample table looks like. 

Set up the criteria range 

Type your criteria, in a separate range on the worksheet.  
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Apply Excel Advanced Filter 

In the criteria range apply an advanced filter as follows: Select any single cell within your dataset. 

Go to the Data tab >Sort & Filter group and click 

Advanced Filter  

Action. Choose whether to filter the list in place or copy the results to another location. 

List range. It's the range of cells to be filtered, the column headings should be included. 

Criteria range. It's the range of cells in which you input the criteria. 

Finally, click OK, and you will get the following result: 

 

 

 

 

 

Summary:  

Microsoft Excel is a powerful spreadsheet application widely used for data organization, analysis, and 

visualization. It allows users to create and manage spreadsheets that can handle complex calculations, data 

modelling, and reporting. Microsoft Excel is an essential tool for professionals across various industries, enabling 

effective data manipulation, analysis, and presentation. Mastery of its features can significantly enhance 

productivity and decision-making capabilities. 
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Check your Understanding: 

Question 1 

MS Excel is a ________Software 

a) Database Management software  

b) Presentation software 

c) Wordbook software 

d) Spreadsheet Software 

Question 2 

MS Excel 2016 has column limit of ________  

a) 13684 

b) 16384 

c) 18634 

d) 84163 

Question 3 

Formulas in Excel start with ________ 

a) / 

b) f 

c) - 

d) = 

Question 4 

______function in MS Excel worksheet represents the total number of entries in the cell 

a) Sum 

b) Average 

c) Count 

d) Total 

 

Question 5 

A function inside another function is called 

a) Round 

b) Sum 

c) Text 

d) Nested 

 

 



 

C D T A  P a g e  70 | 111 

 

Youth Computer Training Centre 

Question 6 

You can set Page Border in Excel from 

a) From Border tab in Format Cells dialog box 

b) From Border tool in Formatting toolbar 

c) From Line style tool in Drawing toolbar 

d) You can’t set page border in Excel 

Question 7 

How do you display current date and time in Word 

a) Date() 

b) Today() 

c) Now() 

d) Time() 

Question 8 

Give me an example of Absolute reference 

a) $F15 

b) F$15 

c) $F$15 

d) F15 

Question 9 

How to restrict the values of a cell so that only whole numbers between 10 and 100 can be entered in a cell? 

a) Data Table 

b) Advanced Filter 

c) Data Validation 

d) Fill Series 

Question 10 

In Excel two common wildcard characters that it recognizes are – 

a) and ? 

b) < and > 

c) ^ and / 

d) + and – 
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Chapter 5:   Microsoft Access 2016 
Introduction 

Microsoft Access 2016 is a database management system (DBMS) for storing, organizing and analysing data. 

Microsoft Access 2016 leaning objectives as Basic || Intermediate || Advanced 

 

• Understanding the Access 2016 interface, including the Ribbon, Navigation Pane. 

• Create, save and open databases. 

• Design and create tables, fields and data types. 

• Put the Data, edit and delete data. 

• Create and run simple queries using Tables. 

• Use relationships and validation. 

• Query, joins and functions. 

• Create Form for Input entry. 

• Report Creation and generate reports with Print Preview. 

• Data grouping, sorting and filtering. 

• VBA Programming: Create macros using code. 

• Manage access, passwords with Exclusive modes. 

• Data Import/Export with Excel, Word and other applications. 
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About Microsoft Access 2016 

Microsoft Access is a Database Management System (DBMS) from Microsoft that combines the relational 

Microsoft Jet Database Engine with a graphical user interface and software development tools. It is a member of 

the Microsoft Office suite of applications, included in the professional and higher editions. 

• Microsoft Access is   just   one   part   of   Microsoft's   overall   data   management   product strategy. 

• It stores data in its own format based on the Access Jet Database Engine. 

• Like relational databases, Microsoft Access   also   allows   you   to   link   related   information easily. For 

example, customer and order data.   However, Access   2016   also   complements other database 

products because it has several powerful connectivity features. 

• It can also import or link directly to data stored in other applications and databases. 

• As its name implies, Access can work directly with data from other sources, including many popular PC 

database programs, with many   SQL   (Structured   Query   Language) databases on the desktop, on 

servers,   on   minicomputers,   or   on   mainframes,   and   with data stored on Internet or intranet web 

servers. 

• Access can also understand and use   a   wide   variety   of   other   data   formats, including many other 

databases file structures. 

• You can export data to and import data from word processing files, spreadsheets, or database files 

directly. 

• Access can work with most popular databases that support the Open Database Connectivity (ODBC) 

standard, including SQL Server, Oracle, and Db2. 

• Software developers can use Microsoft Access to develop application software. 

• Microsoft Access stores information which is called a database. To use MS Access, you will need to follow 

these four steps: 

• Database Creation - Create your Microsoft Access   database   and   specify what   kind   of data you will 

be storing. 

• Data Input - After your database is created, the data of every business day can be entered into the Access 

database. 

• Query - This is a fancy term to basically describe the process of retrieving information from the database. 

• Report (optional) - Information from the database is organized in a nice presentation that can be printed 

in an Access Report. 
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Architecture 

• Access calls anything that can have a name   an   object.   Within   an   Access   desktop database, the   

main   objects   are   tables, queries, forms, reports, macros, data   macros, and modules. 

• If you have   worked   with   other   database   systems   on   desktop   computers, you   might have seen 

the term database used to refer to only those files in which you store data. 

• But, in Access, a desktop database (.accdb) also includes all the major objects related to the stored data, 

including objects you define to automate the use of your data. 

• Before MS Access 2007, the file extension was *.mdb, but in MS Access 2007   the extension has been 

changed to *.accdb extension. 

• Early versions of Access cannot read accdb extensions but MS Access 2007   and   later versions can 

read and change earlier versions of Access. 

• It provides all the data definition, data manipulation, and data control features that you need to manage 

large volumes of data. 

• You can use an Access desktop database (.accdb or .mdb)   either   as   a   standalone RDBMS on a 

single workstation or in a shared client/server mode across a network. 

• A desktop database can also act as the data source for data displayed on webpages on your company 

intranet. 

• When you build an application with an Access desktop database, Access is the RDBMS. 

Data Definition 

Let us now understand what Data Definition is: 

• In document or a spreadsheet, you generally have complete freedom to define the contents of 

the document or each cell in the spreadsheet. 

• In a document, you can include paragraphs of text, a table, a chart, or multiple columns of data displayed 

with multiple fonts. 

• In spreadsheet, you can have text data at the top to define a column header for printing or display, and 

you might have various numeric   formats   within   the   same   column, depending on the function of the 

row. 

• An RDBMS allows you to define the kind of data you have and how the data should be stored. 

• You can also usually define rules that the RDBMS can use to ensure the integrity of your data. 

• For example, a validation rule might ensure   that   the   user   can't   accidentally   store alphabetic 

characters in a field that should contain a number. 
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Data Manipulation 

Working with data in RDBMS is very different from working with data in a word processing or spreadsheet 

program. 

• In a word processing document, you can include tabular data and perform a limited set of functions on 

the data in the document. 

• You can also search for text strings in the original document and, with ActiveX controls, include tables, 

charts, or pictures from other applications. 

• In a spreadsheet, some cells contain functions that determine the result you want, and in other cells, you 

enter the data that provides the source information for the functions. 

An RDBMS provides you many ways to work with your data. For example, 

• You can search a single table for information or request a complex search across several related tables. 

• You can update a single field or many records with a single command. 

• You can write programs that use RDBMS commands to fetch data that you want to display and allow the 

user to update the data. 

• Access uses the powerful SQL database language to process data in your tables. Using SQL, you can 

define the set of information that you need to solve a particular problem, including data from perhaps 

many tables. 

Data Control 

Spreadsheets and word processing documents are great for solving single-user problems, but they are difficult to 

use when more than one person needs to share the data. 

• When you need to share your information with others, RDBMS gives you the flexibility to allow multiple 

users to read or update your data. 

• An RDBMS that is designed to allow data sharing also provides features to ensure that no two people 

can change the same data at the same time. 

• The best systems also allow you to group changes (which is also known as transaction) so that either all 

the changes or none of the changes appear in your data. 

• You might also want to be sure that no one else can view any part of the order until you have entered all 

of it. 

• Because you can share your Access data with other users, you might need to set some restrictions on 

what various users are allowed to see or update. 
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MS Access uses “objects" to help the user list and organize information, as well as prepare specially designed 

reports. When you create a database, Access offers you Tables, 

Queries, Forms, Reports, Macros, and Modules. Databases in Access are composed of many objects but the 

following are the major objects: 

• Tables 

• Queries 

• Forms 

• Reports 

 

Together, these objects allow you to enter, store, analyze, and compile your data. Here is a summary of the major 

objects in an Access database: 

Table 

Table is an object that is used to define and store data. When you create a new table, Access asks you to define 

fields which is also known as column headings 

• Each field must have a unique name, and data type. 

• Tables contain fields or columns that store different kinds of data, such as a name or an address, and 

records or rows that collect all the information about a particular instance of the subject, such as all the 

information about a customer or employee etc. 

• You can define a primary key, one or more fields that have a unique value for each record, and one or 

more indexes on each table to help retrieve your data more quickly. 

Query 

An object that provides a custom view of data from one or more tables. Queries are a way of searching for and 

compiling data from one or more tables. 

• Running a query is like asking a detailed of your database. 

• When you build a query in Access, you are defining specific search conditions to find exactly the data you 

want. 

• In Access, you can use the graphical query by example facility or you can write Structured Query 

Language (SQL) statements to create your queries. 

• You can define queries to Select, Update, Insert, or Delete data. 

• You can also define queries that create new tables from data in one or more existing tables. 
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Form 

Form is an object in a desktop database designed primarily for data input or display or for control of application 

execution. You use forms to customize the presentation of data that your application extracts from queries or 

tables. 

• Forms are used for entering, modifying, and viewing records. 

• The reason forms are used so often is that they are an easy way to guide people toward entering data 

correctly. 

• When you enter information into a form in Access, the data goes exactly where the database designer 

wants it to go in one or more related tables. 

 

 

Report 

Report is an object in desktop databases designed for formatting, calculating, printing, and summarizing selected 

data. 

 

• You can view a report on your screen before you print it. 

• If forms are for input purposes, then reports are for output. 

• Anything you plan to print deserves a report, whether it is a list of names   and addresses, a financial 

summary for a period, or a set of mailing labels. 

• Reports are useful because they allow you to present components of your database in an easy-to-read 

format. 

• You can even customize a report's appearance to make it visually appealing. 

• Access offers you the ability to create a report from any table or query. 
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Other MS Access Objects 

Let us now take a look at other MS Access objects. 

Macro 

This object is a structured definition of one or more actions that you want Access to perform in response to a 

defined event. An Access Macro is a script for doing some job. For example, to create a button which opens a 

report, you could use a macro which will fire Open Report action. 

• You can include simple conditions in macros to specify when one or more actions in the macro should be 

performed or skipped. 

• You can use macros to open and execute queries, to open tables, or to print or view reports. 

• You can also run other macros or Visual Basic procedures from within a macro. 

• Data macros can be attached directly to table events such   as   inserting   new   records, editing existing 

records, or deleting records. 

• Data macros in web apps can also be stand-alone objects that can be called from other data macros or 

macro-objects. 

 

 

Module 

Module is an object in desktop databases containing custom procedures that you code using Visual Basic. 

Modules provide a more discrete flow of actions and allow you to trap errors. 

• Everything that can be done in a macro can also be done in a module, but you don't get the macro 

interface that prompts you what is needed for each action. 

• Modules are far more powerful, and are essential if you plan to write code for a multi user environment, 

because macros cannot include error handling. 

• Modules can be   standalone   objects   containing   functions   that   can   be   called   from anywhere in 

your application, or they can be directly associated with a form or a report to respond to events on the 

associated form or report. 

Create Blank Database 

Sometimes database requirements can be so specific that using and modifying the existing templates requires 

more work than just creating a database from scratch. In such case, we make use of blank database. 

Step 1: Let us now start by opening MS Access. 

Step 2: Select Blank desktop database. Enter the name and click the Create button. 
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Step 3: Access will create a new blank database and will open up the table which is also completely blank. 

 

MS Access Data Types 

Every field in a table has properties and these properties define the field's characteristics and behaviour. The most 

important property for a field is its data type. A field's data type determines what kind of data it can store. MS 

Access supports different types of data, each with a specific purpose. 

Here are some of the most common data types you will find used in a typical Microsoft Access database. 

Type of Data Description Size 

Short Text 
Text or combinations of text and numbers, including 
numbers that do not require calculating (e.g. phone 

numbers). 
Up to 255 characters. 

Long Text Lengthy text or combinations of text and numbers. Up to 63, 
999 characters. 

Number Numeric data used in mathematical calculations. 
1, 2, 4, or 8 bytes (16 

bytes if set to 
Replication ID). 

Date/Time Date and time values for the years 100 through 9999. 8 bytes. 

Currency Currency values and numeric data used in mathematical 
calculations involving data with one to four decimal places. 8 bytes. 

Auto Number 
A unique sequential (incremented by 1) number or random 

number assigned by Microsoft Access whenever a new 
record is added to a table. 

4 bytes (16 bytes if set 
to Replication ID). 

Yes/No Yes and No values and fields that contain only one of two 
values (Yes/No, True/False, or On/Off). 

1 bit. 
 

 

If you use previous versions of Access, you will notice a difference for two of those data types. 

In Access 2013, we now have two data types — short text and long text. In previous versions of Access these 

data types were called text and memo. Here are some of the other more specialized data types. 

Data Types Description Size 

Attachment 
Files, such as digital photos. Multiple files can be attached 
per record. This data type is not available in earlier 
versions of Access. 

Up to about 2 GB 

OLE objects 
OLE objects can store pictures, audio, 
video, or other BLOBs (Binary Large 
Objects) 

Up to about 2 GB. 
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Hyperlink Text or combinations of text and numbers 
stored as text and used as a hyperlink address. 

Up to 8,192 (each part 
of a Hyperlink data 
type can contain up 
to 2048 characters). 

Lookup Wizard 

The Lookup Wizard entry in the Data Type column in the 
Design view is not actually a data type. When you choose 
this entry, a wizard starts to help you define either a 
simple or complex lookup field. A simple lookup field uses 
the contents of another table or a value list to validate the 
contents of a single value per row.  

Dependent on the 
data type of the 
lookup field. 

Calculated 
You can create an expression that uses data 
from one or more fields. You can designate 
different result data types from the expression. 

You can create an 
expression that uses 
data from one or more 
fields. You can 
designate different 
result data types 
from the expression. 

 

 

Create Table 

When you create a database, you store your data in tables. Because other database objects depend so heavily 

on tables, you should always start your design of a database by creating all of its tables and then creating any 

other object. We will now create a table using the Table Design View. We will be creating the following fields in 

this table. 

Field Name Data Type 
Project ID Auto Number 

Project Name Short Text 
Managing Editor Short Text 

Author Short Text 
P Status Short Text 
Contracts Attachment 

Project Start Date/Time 
Project End Date/Time 

Budget Currency 
Project Notes Long Text 

 

Let us now go to the Create tab. 

In the tables group, click on Table. In this view, you can see the field name and data type side by side. 
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We now need to make Project ID a primary key for this table, so let us select Project ID and click on Primary Key 

option in the ribbon. 

 

Adding Data 

Select the Views > Datasheet View option in the ribbon and add some data as shown in the following screen shot. 

 

Queries 

Queries are used for viewing, modifying and deleting records held within database tables. Queries do not 

themselves store records but contain instructions that describe which records to retrieve from the underlying 

tables, creating a temporary dataset. 
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With a query you can: 

• Choose which fields of the tables are displayed 

• Specify criteria so only the matching records are shown 

• Define sorting orders 

• Combine data from multiple related tables 

Constructing queries 

Queries are designed and modified using the Query By Example (QBE) grid, and their results are seen in the 

Datasheet view. You can switch between views using the Design > Results > View button (a query must contain 

at least one data field to be viewable). 

a) The top pane of the QBE grid shows any tables used by the query. 

b) The bottom pane shows the fields from these tables that will be used in the query. 

Making a new query 

A Query Wizard is included in Access, but it is generally more difficult to use than designing from scratch: 

i. Choose Create > Queries > Query Design to begin a new query. The Show Table dialogue will open 

automatically. 

ii. Select the table you wish to use, choose Add, then Close the dialogue. 

iii. Add the fields you need to use in the query: 

iv. Double-click on the field name in the table or 

v. Drag the field from the table to the lower section of the grid 

Editing tables and fields 

i. Deleting tables: select the table, then press Delete (keyboard). 

ii. Adding tables: Choose Design > Query Setup > Show Table, select and Add the table, and Close the 

dialogue. 

iii. Delete a field: select the field and press Delete (keyboard) 

iv. Move a field: select the field and drag it to a new location on the grid 

Configuring queries 

The main things you will want to configure are visibility, sort order and criteria. 

Sorting 

A sort order can be applied to one or more fields, text and numeric. The sorting is always applied from left to right, 

so you may need to re-order the fields to get the result you want. 
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Visibility 

A field will not display in Datasheet view if the box in the Show row 

is not ticked. You are most likely to do this if you want to apply a sort order or criteria to a field but do not want to 

see that field in the result. 

 

Criteria 

Using the criteria row to define which data is retrieved will apply potentially complex filters to your data. It is an 

essential part of query design, and is covered in detail below. 

Structured Query Language (SQL).  

Variations of SQL are used by all common database systems. 

If you are interested in learning SQL, one approach is to create a simple query using QBE and then choose the 

SQL View instead of Design or Datasheet. You can then inspect the SQL and figure out the syntax. 
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Filtering in queries 

Setting criteria in the QBE grid restricts the results to those records that match the conditions set. Criteria can be 

set on text, number, and date fields but the syntax is different. 

• Criteria for text fields should be enclosed in double quotation marks. They are not case sensitive. 

• Criteria for numeric fields must not be enclosed in quotation marks. 

• Criteria for date fields must be enclosed in hash characters. 

Conditions, ranges and wildcards 

A wide range of other symbols and syntax may be used to define criteria more precisely. 

Number ranges 

> greater than less than 
< greater or equal to less than 
>= or equal to 
<= (insert values) 
Between … And … 

Date ranges 

> after before on or after on 
< or before (insert #dates#) 
>= 
<= 
Between … And … 

Not equal to Not or <> 

No data 
('empty' 
fields) 

A special value of NULL is provided for use when locating or 
excluding records that contain no value in a specific field. A Null 
value is not the same as a numeric field having a value 
of zero. 
Is Null – displays only records where no value is entered 
Is Not Null – displays only records where a value is present 

 

SUMMARY OF ACCESS 2016 

Microsoft Access online works well with many of the development languages that work on Windows. It is robust 

and flexible, and it can perform any challenging office or industrial database tasks.MS-Access allows you to link 

to data in its existing location and use it for viewing, updating, querying, and reporting. 

• Affordable solution: Suitable for small to medium-sized businesses and smaller teams within larger 

organizations. 

• Reduced consulting costs: Users can design and control the database without relying on external 

consultants. 

• Easy learning curve: More intuitive than client-server databases. 

• User-friendly interface: Simplifies database management for non-technical users. 

• Integration with Microsoft Office: Seamless import/export with Excel, Word and other Office applications. 

• Local hosting: Databases can reside on servers, desktops or laptops without requiring cloud solutions. 

• Linking capabilities: Connects to external databases for querying and reporting. 

• SQL support: Enables Structured Query Language for advanced database interactions. 
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Check your understanding 

Question 1 

Queries in MS Access can be used 

a) To view data 

b) As source for forms 

c) As source for Reports 

d) All of these  

Question 2 

Which of the following shows the final result in a presentable way ? 

a) Forms 

b) Reports 

c) Queries 

d) Tables  

Question 3 

Microsoft Access provides visual environment for design of _______. 

a) tables 

b) reports 

c) forms 

d) all of them  

Question 4 

By default, new table is displayed in ______view. 

a) Datasheet View 

b) Design View 

c) Report View 

d) Form View  

Question 5 

An ordinary form for data entry in MS Access tables may be created using______ menu. 

a) Create>Form 

b) Create>Split Form 

c) Create>Multiple Items 

d) Create>Blank Form  
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Question 6 

In MS Access, form may be manually designed through available components (like text field,  

date picker, combo-box, etc.) using ______menu. 

a) Create>More Forms>Form Wizard 

b) Create>More Forms>Data Sheet 

c) Create>More Forms>Modal Dialog 

d) Create>Form Design  

Question 7 

Which view allows to modify table’s structure in Access? 

a) Design view 

b) Datasheet view 

c) Pivot table view 

d) Pivot shart view 

Question 8 

To duplicate a controls formatting you can use________ 

a) Manager 

b) Wizard  

c) Painter  

d) Control  

Question 9 

Which of the following is not a database application? 

i. Base 

ii. Flash 

iii. FoxPro  

iv. Access  

Question 10 

Which is the valid data type in Access? 

v. Number 

vi. Text 

vii. Currency 

viii. All of the above 
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Chapter 6:   Microsoft PowerPoint 2016 
 

Introduction 

• Understand the basic features and interface of MS PowerPoint. 

• Learn to create, format & Organize New Presentation. 

• Develop skills in adding and editing text, images, and multimedia. Master slide design, layout, and 

customization options 

• Explore transitions, animations, and visual effects. Learn to present slideshows and manage presentation 

flow 

• Gain proficiency in using templates and themes for consistent design 

• Understand best practices for creating engaging and professional presentations. 

 

POWERPOINT  

Microsoft PowerPoint is a professional presentation program that allows the user to create "presentation slides" 

that can be displayed on the computer screen or through a projector that is plugged in to the computer. A 

PowerPoint presentation is a good way to convey pieces of information, usually in the form of an outline, to a 

large audience.  

 

Getting started with Microsoft PowerPoint 

1. Click Start → Programs 
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Microsoft PowerPoint 

• File Menu and Backstage View 

• Quick Access Toolbar (QAT) 

• Ribbon 

• Slides Pane 

• Slide Area 

• Task Pane 

• Status Bar 

• Notes Pane 

• View Buttons 

• Mini Toolbar 

 

Creating a PowerPoint presentation 

Create a blank presentation that consists only of a title slide, add slides and slide content, and then format the 

presentation. We can Import a list of slide titles from a text document, add slide content and a title slide, and then 

format the presentation. We Import slide titles and content from a Microsoft Word file, add a title slide, and then 

format the presentation. Create a preformatted or prepopulated presentation based on a local or online template. 

When PowerPoint is running, you can create a blank or prepopulated presentation from the New page of the 

Backstage view. Built-in, online, and custom templates are available from the New page By default, a new 

presentation includes only a title slide. You can add blank content slides to the presentation, or copy or move 

slides from another presentation. 
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To create a blank presentation 

Start PowerPoint. On the start screen, press Esc or click Blank Presentation. On the New page of the Backstage 

view, click Blank Presentation. From the program window, press Ctrl+N. 

Create a Presentation based on a template 

Creating attractive presentations from scratch can be time-consuming. You can save time by basing your 

presentation on one of the templates that come with PowerPoint. Two types of templates are available when 

creating a new presentation: 

Design template This is a blank presentation with a theme 

Content template From the PowerPoint start screen, you can preview and download presentation templates that 

are available from the Office website. 

 

Formatting slide backgrounds 

You can customize the background of an individual slide by adding a solid color, a color gradient, a texture, or 

even a picture. In the Format Background pane, you can specify the colors, texture, pattern, or picture that appear 

on the background of the current slide or slide master. You can configure a simple yet elegant slide background 
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by displaying a solid color or color gradient that reflects the color scheme applied to the presentation. You can 

configure a more complex slide background by selecting one of the 15 built-in textures or 48 patterns 

that can be customized with any two colors. Each texture is a small graphic that is tiled on the slide and designed 

to repeat gracefully, both horizontally and vertically. 

Changing slide size 

By default, PowerPoint 2016 slides are sized for a widescreen display (13.333 inches by 7.5 inches). The slides 

are oriented horizontally, with slide numbers starting at 1. You can set the size and orientation of the slides, and 

the orientation of notes, handouts, and outlines, to fit your intended distribution methods. You modify these 

attributes in the Slide Size dialog box. 

You can select from the following slide sizes: 

On-screen Show 

For an electronic slide show on screens of various aspects (4:3, 16:9, or 16:10) 

Letter Paper → For a presentation printed on 8.5-by-11-inch US letter-size paper 

Ledger Paper→ For a presentation printed on 11-by-17-inch ledger-size paper  

A3 Paper, A4 Paper, B4 (ISO) Paper, B5 (ISO) 

Paper For a presentation printed on paper of various standard international sizes 35mm Slides For 35mm slides 

to be used in a carousel with a projector Overhead For transparencies for an overhead projector. Banner For a 

webpage banner Widescreen For a widescreen monitor display Custom For slides that are a nonstandard size. 

Create a presentation in PowerPoint 

▪ Open PowerPoint. 

▪ In the left pane, select New. 

▪ Select an option: 

▪ To create a presentation from scratch, select Blank Presentation. 

▪ To use a prepared design, select one of the templates. 

▪ To see tips for using PowerPoint, select Take a Tour, and then select 

Add a slide 

i. In the thumbnails on the left pane, select the slide you want your new slide to follow. 

ii. In the Home tab, in the Slides section, select New Slide. 

iii. In the Slides section, select Layout, and then select the layout you want from the menu. 
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Add and format text 

i. Place the cursor inside a text box, and then type something. 

ii. Select the text, and then select one or more options from the Font section of the Home tab, such as Font, 

Increase Font Size, Decrease Font Size, Bold, Italic, Underline, etc. 

iii. To create bulleted or numbered lists, select the text, and then select Bullets or Numbering. 

Add a picture, shape, and more 

Go to the Insert tab → To add a picture: 

• In the Images section, select Pictures. 

• In the Insert Picture From menu, select the source you want. 

• Browse for the picture you want, select it, and then select Insert. 

To add illustrations: 

• In the Illustrations section, select Shapes, Icons, 3D Models, SmartArt, or Chart. 

• In the dialog box that opens when you click one of the illustration types, select the item you want and 

follow the prompts to insert it. 

 

How to apply multiple Animations 

If you've ever seen a PowerPoint presentation that had special effects between each slide, you've seen slide 

transitions. A transition can be as simple as fading to the next slide or as flashy as an eye-catching effect. 

PowerPoint makes it easy to apply transitions to some or all of your slides, giving your presentation a polished, 

professional look. 

You can preview the transition for a selected slide at any time using either of these two methods: 

• Click the Preview command on the Transitions tab. 

• Click the Play Animations command in the Slide Navigation pane. 
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Apply multiple animation effects to one object 

In the PowerPoint desktop apps, you can apply multiple animation effects to a single string of text or an object, 

such as a picture, shape, or SmartArt graphic. 

Tip: When working with multiple animation effects, it helps to work in the Animation Pane, where you can see a 

list of all the animation effects for the current slide. 

Open the Animation Pane 

• Select the object on the slide that you want to animate. 

• On the Animations tab, click Animation Pane. 

• Click Add Animation, and pick an animation effect. 

➔ To apply additional animation effects to the same object, select it, click Add Animation and pick another 

animation effect. 

 

Set the start time and length of an animation effect 

When you want to control the timing of your animation effects, do the following for each animation effect: 

i. In the Animation Pane, click the down arrow next to the animation effect, and then click Timing. 

ii. On the Timing tab, click the Start down arrow, and choose from the following start times: 

• To play when you click the mouse, pick On Click. 

• To play at the same time as the previous animation effect, pick With Previous 

• To play after the previous animation effect plays, pick  
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SUMMARY  

• Understanding New User Interface: Use simplified user-friendly interface with a ribbon that provides quick 

access to various tools and features and use of Tell Me tool to find new commands quickly and easily. 

• New Themes and Templates: Improved design themes and templates that make it easy to create 

professional-looking presentations with updated designer feature which provides design suggestions as 

users add new content to their slides. 

• Enhanced Association: Allows multiple users to work on a presentation simultaneously. You can add 

comments to slides, helping better communication among team members. 

• Smart Guides: It helps to align objects like text, objects and graphics on slides, making it easier to create 

visually attractive layouts. 

• Animation and Transition effects: Various animation options to create smooth animations of objects in slides 

as well as transition between slides, giving presentations a more dynamic feel. 

• Insert Media: You can attach videos and audio files directly into slides, at the same time "Insert Online Video" 

feature allows embedding from popular platforms like YouTube. 

• Export and Share Options: You are ready to export presentations as PDFs or share them directly via email 

or One Drive which makes it easy to distribute content to others. 

 

 

 

 

 

 



 

C D T A  P a g e  93 | 111 

 

Youth Computer Training Centre 

 

Check your understanding 

Question:1 

What is a Microsoft PowerPoint? 

a) Spreadsheet Program 

b) Presentation Program 

c) Database Program 

d) All of the above 

Question:2 

Which of the following shortcut key is used to start the slideshow? 

a) Using F5 key 

b) Using F3 key 

c) Using F1 key 

d) Using F6 key 

Question:3 

What is the best way to create another copy of a slide? 

a) Click the slide then press Ctrl+A and paste in new slide 

b) From Insert Menu choose Duplicate Slide 

c) Redo everything on a new slide that you had done on previous slide 

d) None of above 

Question: 4 

In a PowerPoint presentation - 

a) We can insert movie clips but not the sound clips 

b) We can insert sound clips but not the movie clips 

c) Both movie clips and sound clips can be inserted 

d) Both movie clips and sound clips cannot be inserted 

Question:5 

What is the easiest way to place same graphic in same place in all slides 

a) Place graphic in Notes Master 

b) Place graphic in Slide Master 

c) Place graphic in Handout Master 

d) Place graphic manually in all slide 
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Question:6 

MS PowerPoint is software of ____ 

a) Google 

b) Apple 

c) Android 

d) Microsoft 

Question:7 

What are the three options available in Insert >> Picture menu? 

a) Clipart, Pictures, Shapes 

b) Clipart, From File, Shapes 

c) Clipart, From Files, AutoShapes 

d) Clipart, Pictures, AutoShapes 

Question:8 

Which of the following method can insert a new slide in current presentation? 

a) Right click on the Slide panel and choose New Slide 

b) From Insert menu choose New Slide 

c) Click on New Slide button on toolbar 

d) All of above 

Question:9 

What is the keyboard shortcut to start the slideshow from the current slide of a PowerPoint presentation? 

a) F5 

b) Ctrl+F5 

c) Shift+F5 

d) Ctrl+F12 

Question:10 

Boxes with dotted or hatch marked borders that are part of most slide layouts are called as 

a) Placeholder 

b) Line spacing 

c) Header 

d) Footer 
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Chapter 7:   Cyber Security Basic 
Introduction 

The primary goal of cyber security is to protect information systems from various cyber threats and ensure the 

integrity, confidentiality, and availability of data. 

Cyber Security Basic 

Cyber security is the most concerned matter in our present life. Nowadays cyber threats and attacks are 

overgrowing, sophisticated techniques are used to target the computer systems. So, all the IT or non-IT firms 

have understood the importance of Cyber Security. 

 

What is Cyber security? 

Cyber security is the technologies/processes to protect computer programs and data from unauthorized access 

(attack). The term “cyber security” refers to techniques and practices designed to protect digital data. 

 

 

Types of Cyber Attacks 

A cyber-attack is an exploitation of computer systems and networks. Malicious code use used to alter computer 

code, logic or data. Which can refer as “cybercrimes”, Cyber-attacks can be classified into two categories 

i. Web-based attacks  

ii. System-based attacks  
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Web-based attacks: - 

 

Web based attacks occur on a website or web applications. Some of the web-based attacks are as follows. 

• Injection attacks 

In this type of attack some data will be injected into a web application to manipulate the application. SQL Injection, 

code Injection, log Injection, XML Injection are the example of Injection attacks etc. 

• DNS Spoofing 

DNS spoofing is known as a computer security hacking. 

• Session Hijacking 

It is a security attack on a user session over a protected network. 

• Phishing 

This type of attack attempt to steal sensitive information like user login credentials and credit card number etc. 

• Brute force 

It is a attack which uses a trial and error method. 

• Denial of Service 

This type of attack make a server or network resource unavailable to the users. 

• Dictionary attacks 

This type of attack stored the list of a commonly used password and validated them to get original password. 

• URL Interpretation 

This type of attack can change the certain parts of a URL, so the unauthorized person can get the web page from 

web server. 

• File Inclusion attacks 

It is a type of attack that allows an attacker to access unauthorized or essential files. 

• Man in the middle attacks 

This type of attack helps an attacker to intercepts the connection between client and server. 
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System-based attacks 

These are the attacks which are intended to compromise a computer or a computer network. Some of the 

important system-based attacks are as follows- 

• Virus 

It is a type of malicious software program that spread throughout the computer files without the knowledge of a 

user. It is a self-replicating malicious computer program. It can also execute instructions that cause harm to the 

system. 

• Worm 

It is a type of malware whose primary function is to replicate itself to spread to uninfected computers. Worms 

often originate from email attachments. 

• Trojan horse 

It is a malicious program that occurs unexpected changes to computer setting and unusual activity, even when 

the computer should be idle. 

• Backdoors 

It is a method that bypasses the normal authentication process. 

• Bots 

A bot (short for "robot") is an automated process that interacts with other network services.  

Some bots program run automatically, Common examples of bots program are the crawler, chatroom bots. 

• Ransomware 

Ransomware is malware that encrypts a victims important files in demand of a payment to  

restore access. 

The 7 layers of cyber security: 

• Mission Critical Assets 

This is the data you need to protect 

• Data Security 

Data security controls protect the storage and transfer of data. 

• Application Security 

Applications security controls protect access to an application, an application's access to your mission critical 

assets, and the internal security of the application. 

• Endpoint Security 

Endpoint security controls protect the connection between devices and the network. 
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• Network Security 

Network security controls protect an organization's network and prevent unauthorized access of the network. 

• Perimeter Security 

Perimeter security controls include both the physical and digital security methodologies that protect the business 

overall. 

• The Human Layer 

Humans are the weakest link in any cyber security posture. Human security controls include phishing simulations 

and access management controls that protect mission critical assets from a wide variety of human threats, 

including cyber criminals. 

Cyber threats ` 

Cyber threats are security incidents or circumstances with the potential to have a negative outcome for your 

network or other data management systems. 

Computer criminals 

Computer criminals have access to enormous amounts of hardware, software, and data purpose of computer 

security is to prevent these criminals from creating damage. Computer crime is a crime involving with computer 

by the unauthorized person. 

CIA Triad 

The CIA Triad is actually a security model that has been developed to help people think about various parts of IT 

security. 

CIA Triad broken down 

Confidentiality 

It's crucial in today's world for people to protect their sensitive, private information from unauthorized access. 

Integrity 

Data integrity is what the "I" in CIA Triad stands for essential component of the CIA Triad and designed to protect 

data from deletion or modification from any unauthorized party. 

Availability 

This is the final component of the CIA Triad and refers to the actual availability of your data. 

Motive of Attackers 

Motivations of cyber-attacker's actions are three types 

• Inadvertent actions (generally by insiders) that are taken without malicious or harmful intent. 

• Deliberate actions (by insiders or outsiders) that are taken intentionally and are meant to do harm 

• Inaction (generally by insiders) 
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Such as a failure to act in a given situation, either because of a lack of appropriate skills, knowledge, guidance, 

or availability of the correct person. 

 

Assets 

An asset is any data, device or other component of an organization such as an employee's desktop computer, 

laptop. An organization's most common assets are information assets. These are things such as databases and 

physical files. 

Threat 

A threat is any incident that could negatively affect an asset – for example, if it's lost, accessed by an unauthorized 

party. 

Cyber Threats-Cyber Warfare 

Cyber warfare refers to the use of digital attacks -- like computer viruses and hacking for example, computer 

viruses or denial-of-service attacks. 

Cyber Crime 

Cybercrime is criminal activity that either targets or uses a computer, a computer network or a networked device. 

Cyber Terrorism 

Cyber terrorism is the convergence of cyberspace and terrorism. It refers to unlawful attacks and threats of 

attacks against computers, networks and the information stored therein 

Cyber Espionage 

Cyber spying, or cyber espionage, is the act or practice of obtaining secrets and information  

without the   permission 

CYBERSPACE 

Cyberspace can be defined as an intricate environment that involves interactions between people, software, and 

services. It is maintained by the worldwide distribution of information and communication technology devices and 

networks. 

REGULATIONS 

There are five predominant laws to cover when it comes to cybersecurity: 

Section 43 - Applicable to people who damage the computer systems without permission from the owner. The 

owner can fully claim compensation for the entire damage in such cases. 

Section 66 - Applicable in case a person is found to dishonestly or fraudulently committing any act referred to in 

section 43. The imprisonment term in such instances can mount up to three years or a fine of up to Rs. 5 lakh. 
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Section 66B - Incorporates the punishments for fraudulently receiving stolen communication devices or 

computers, which confirms a probable three years imprisonment. This term can also be topped by Rs. 1 lakh 

fine, depending upon the severity. 

Section 66C - This section scrutinizes the identity thefts related to imposter digital signatures, hacking 

passwords, or other distinctive identification features. If proven guilty, imprisonment of three years might also be 

backed by Rs.1 lakh fine. 

Section 66 D - This section was inserted on-demand, focusing on punishing cheaters doing impersonation using 

computer resources. 

Indian Penal Code (IPC) 1980 

Identity thefts and associated cyber frauds are embodied in the Indian Penal Code (IPC), 1860 - invoked along 

with the Information Technology Act of 2000. 

Laws of Cyber security in India  

In India, cyber security laws are governed by a combination of specific legislation and regulations aimed at 

protecting information and ensuring cyber safety. Here are some key laws and regulations:  

Information Technology Act, 2000 (IT Act): The primary legislation governing cybercrime and electronic commerce 

in India.  

Includes provisions for the legal recognition of electronic records and signatures, as well as penalties for cyber 

offenses such as hacking, identity theft, and data breaches.  

Indian Penal Code (IPC): Various sections of the IPC address cybercrimes, such as fraud, defamation, and 

obscenity, which can occur in digital formats.  
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Cyber Security Policy (2013): A national policy that outlines the framework for securing India’s cyberspace, 

promoting the establishment of a secure and resilient cyber environment.  

National Cyber Security Strategy (2020): A comprehensive strategy aimed at enhancing the security of critical 

information infrastructure and promoting a robust cyber security ecosystem in the country.  

Personal Data Protection Bill: A proposed legislation that aims to protect individuals' personal data and establish 

guidelines for data processing by organizations. It is inspired by the GDPR and is currently under consideration 

in Parliament.  

 

Compliance Requirements: Organizations must comply with data protection and cyber security practices as 

prescribed by the IT Act and other relevant regulations, including implementing security measures to protect 

sensitive data.  

Sector-Specific Guidelines: Certain sectors, such as banking and telecommunications, have additional 

guidelines issued by regulatory bodies (e.g., Reserve Bank of India) that mandate specific cyber security 

measures.  
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CERT-In: The Indian Computer Emergency Response Team (CERT-In) is the national agency responsible for 

incident response and providing cyber security guidance to organizations and government entities.  

Digital India Initiative: A government initiative aimed at promoting digital literacy and enhancing cyber security 

awareness among citizens.  

These laws and regulations form the backbone of India’s cyber security framework, aiming to protect individuals 

and organizations from cyber threats while fostering a secure digital environment.   

 

 

 

 

 

 

SUMMARY 

Cyber security is the practice of protecting systems, networks, and data from digital attacks, theft, and damage. 

Its goal is to secure information and maintain the integrity, confidentiality, and availability of data and resources. 

This is critical as cyber threats, such as malware, phishing, ransomware, and social engineering attacks, continue 

to grow in complexity and volume. 
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Check your understanding 

Question: 1 

What is the primary goal of cyber security?  

a) Speed up internet connectivity  

b) Increase computing power  

c) Protect systems, networks, and data from cyber threats  

d) None of the above  

Question: 2 

Which of the following is NOT a common type of cyber-attack?  

a) Phishing  

b) Social Engineering  

c) SQL Injection  

d) Outsourcing  

Question:3 

What does “phishing” refer to in cyber security? 

a) A network scanning tool  

b) A type of social engineering attack  

c) Encrypting sensitive information  

d) None of the above 

Question:4 

Which concept means ensuring only authorized users have access to data? 

a) Availability  

b) Confidentiality  

c) Integrity  

d) Authentication  

Question:5 

Which type of cyber security attack involves flooding a network with excessive traffic to disrupt its services?  

a) Ransomware  

b) Phishing  

c) DoS (Denial of Service)  

d) Spoofing  
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Question:6 

Which of the following is NOT considered a layer of cyber security?  

a) Network Security  

b) Application Security  

c) Artificial Intelligence Security  

d) Information Security   

Question:7 

Which layer of cyber security involves protecting the infrastructure of an organization’s network  

from unauthorized access? 

a) Endpoint Security  

b) Network Security  

c) Application Security  

d) Data Security 

Question:8 

The C in the CIA Triad stands for: 

a) Control  

b) Confidentiality  

c) Connectivity  

d) Compliance  

Question:9 

What is the primary purpose of Confidentiality in the CIA Triad? 

a) Ensuring information is available when needed  

b) Allowing unrestricted access to information  

c) Protecting information from unauthorized access and disclosure  

d) Ensuring the accuracy and reliability of information  

Question:10 

Integrity in the CIA Triad refers to: 

a) Preventing unauthorized users  

b) Keeping data available at all times  

c) Ensuring data is accurate and not  

d) Encrypting sensitive data 

 

 



 

C D T A  P a g e  105 | 111 

 

Youth Computer Training Centre 

 

Chapter 8:   Mobile Operating System Overview 
We have learnt about the basic work of generalize operating system. Now we will learn about the working 

methodology of mobile operating system. Mobile operating system needs to perform all the activities which are 

performed by the generalize operating system. In addition, mobile operating system needs to handle incoming 

and outgoing calls, receiving notification, send and geographical location and provide computing to the mobile 

applications that works. 

 

Mobile Hardware 

Any device that can be easily carried and moved from one place to another is called a mobile device / mobile 

hardware. It may be laptop, PDA, Tablet, smart phone etc. 

Mobile Software 

Mobile software is the program that runs on the mobile hardware. It is responsible to manage the hardware. It is 

an interface between mobile applications and mobile hardware.  

Mobile operating system 

A mobile operating system (OS) is a software platform that allows mobile devices such as smartphones and 

tablets to run applications and perform various functions. Some popular mobile operating systems are as follows 

Android 

Developed by Google, Android is the most widely used mobile operating system. It is based on the Linux kernel 

and provides a customizable and open-source platform for device manufacturers and developers. Android 

supports millions of applications available through the Google Play Store. 
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iOS 

Developed by Apple, iOS is the operating system used exclusively on Apple's mobile devices, including the 

iPhone, iPad, and iPod Touch. iOS is known for its user-friendly interface and tight integration with other Apple 

products and services. The App Store offers a vast selection of applications for iOS devices. 

Windows 10 Mobile 

Developed by Microsoft, Windows 10 Mobile is a mobile operating system that runs on select Windows-based 

smartphones and tablets. However, Microsoft announced that it would end support for Windows 10 Mobile in 

December 2019, and no new features or devices are being developed for it. 

BlackBerry OS 

Developed by BlackBerry Limited (formerly Research In Motion), BlackBerry OS was the operating system used 

on BlackBerry smartphones. However, BlackBerry has transitioned to using Android as its primary operating 

system for its newer devices. 

KaiOS 

KaiOS is a lightweight operating system based on Linux that is designed for feature phones and low-end 

smartphones. It provides a simplified user interface and supports popular apps such as WhatsApp, Facebook, 

and Google Maps. KaiOS is often used in emerging markets and for devices targeting older demographics. 

Mobile operating system is used to run the smartphones, tablets and handheld devices. Modern mobile operating 

system includes the Bluetooth, WIFI, cellular, touchscreen, protected access, GPS (Global Positioning System) 

for mobile navigation, camera to capture the high-quality video and images, speech recognition, voice recorder, 

music player and infrared blaster. Mobile operating system is the system software which are control the mobile 

devices as well as it provides the interaction between the user and the hardware of the mobile. Mobile operating 

system is a real time operating system. 

Responsibilities of mobile operating system 

A good smartphones OS is boot quickly. Nowadays peoples are want to manage the personal information such 

as notes, calendar, to-do lists, alarms and reminders this task are not possible without the mobile operating 

system. Every user now surfing the internet it is not possible without a good mobile operating system. The mobile 

operating system needs to provide highly interactive interface. The mobile devices communicate the various types 

of peripheral devices. Mobile operating system uses communication protocols. 1G, 2G, 3G etc. are the generation 
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of the communication technology. Nowadays various mobile applications like address book, messaging, map, 

phone book run on the mobile. The mobile operating system also manages incoming and outgoing calls. The user 

can manage multiple calls (conference calls) and concurrent calls on the mobile device with the help of User 

Interface (UI). The Latest mobile devices identify its location using GPS (Global Positioning System). 

Functionalities of mobile operating system 

• Computing on Mobility. 

• Location Identification. 

• Call Management. 

• Notification Management. 

• Mobile Hardware Management. 

• Mobile application management. 

• Battery power management. 

 

 

 

Generations of Mobile Feature and Speed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Generation Feature Standards Speed 

1st Generation 1G Voice Communication 
and analog transmission 

Advance Mobile Phone 
System (AMPS), Total 
Access Communication 

System (TACS) 

6 0 0   t o 
1200 Bps 

2nd 
Generation(2G) 

Channel can be use 
by multiple user Digital 

transmission 

GSM- Global System for 
Mobile 9.6 Kbps 

2nd Generation 
(2.5G) 

Video stream and 
Supports web browsing 

GPRS- General Packet 
Radio Service 28Kbps 

3rd 
Generation (3G) Enhanced Video stream UMTS-Universal Mobile 

Telephone System 384 Kbps 

4th 
Generation (4G) High-definition mobile TV LTE-Long Term Evolution 5.8 Mbps 

5th 
Generation (5G) 

Multiple data transfer 
rate 5G New Radio 1GBps 
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Comparison between mobile operating systems 

 

FEATURE ANDROID IOS WINDOWS 10 BLACK BERRY 10 

COMPANY GOOGLE APPLE INC. MICROSOFT BLACK BERRY 
LTD. 

CURRENT 
VERSION 13.00 12.1.3 10.0 10.3 

LICENSE FREE 
PROPERTY EXCEPT 
FOR OPEN-SOURCE 

COMPONENTS 

PROPERTY 
COMMERCIAL 
SOFTWARE 

PROPRIETARY 

OS FAMILY LINUX DARWIN MICROSOFT 
WINDOWS QNX 

SUPPORTED 
CPU ARCHITECTURE ARM 64-BIT ARMV 8-A 32-BIT ARMV7-A ARM 

PROGRAMED 
LANGUAGE 

C, C++, 
JAVA C, C++ .NET, C# C C++ 

 

 

 

 

 

 

 

 

 

Summary 

Mobile operating systems have evolved from basic platforms for calling and texting into powerful ecosystems 

supporting advanced connectivity and applications. Early OS like Palm OS and Symbian were limited, but the 

launch of Android and iOS transformed mobile devices into essential communication tools for productivity and 

entertainment. Now a days Mobile OS involve across business, healthcare, and education, enabling seamless 

integration with apps, IoT, and cloud services. 
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Check your understanding 

Question: 1 

What is the name of first operating system for mobile? 

a) Webos  

b) Tizen  

c) Simon  

d) LuneOS  

Question: 2 

Which of the following are disadvantages of mobile operating systems? 

a) Fragmentation  

b) Battery Drain  

c) Limited Hardware support  

d) All of the above  

Question: 3 

Android is based on the following language? 

a) JAVA  

b) C++  

c) C  

d) None of the above  

Question: 4 

APK stands for 

a) Android Phone Kit  

b) Android Page Kit  

c) Android Package Kit  

d) None of the above  

Question: 5 

What does API stand for? 

a) Application Programming Interface  

b) Android Programming Interface  

c) Android Page Interface  

d) Application Page Interface  
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Question: 6 

Which of the following kernel is used in Android? 

a) MAC  

b) Windows  

c) Linux  

d) Redhat  

Question: 7 

Which OS is designed for blackberry mobile? 

a) Blackberry OS  

b) WebOS  

c) Android OS  

d) Symbian OS  

Question: 8 

Which device enables electronic devices to communicate easily by connecting them over short  

distances? 

a) Bluetooth  

b) PDA  

c) Headphone  

d) Sensor  

Question: 9 

Pie is the version of _________ 

a) Symbian OS  

b) Android OS  

c) WebOS  

d) Apple iOS  

Question: 10 

iOS is a mobile operating system developed by ________ 

a) Apple Inc.  

b) Microsoft  

c) Google  

d) Palm Ltd.  
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THE END 

Great! Practice Regularly. 
 

 

 

 

 


